
 

 

CDGFix 3 Super help 





 

iii 

Table Of Contents 
Welcome to the CDGFix 3 Super online help ................................................................................... 1 

Disclaimer ................................................................................................................................. 3 

Acknowledgments ...................................................................................................................... 5 

CDGFix Crew .......................................................................................................................... 5 

External Credits ...................................................................................................................... 5 

Trademarks ............................................................................................................................ 5 

Supported technologies ............................................................................................................ 5 

Key Features ............................................................................................................................. 7 

What's new ............................................................................................................................... 9 

Contacting CDGFix Crew ........................................................................................................... 11 

Corporate headquarter ........................................................................................................... 11 

Corporate headquarter ........................................................................................................... 11 

Sales department .................................................................................................................. 11 

Technical Support .................................................................................................................. 11 

Submitting suggestions .......................................................................................................... 11 

Getting started ........................................................................................................................ 13 

System requirements ............................................................................................................. 13 

Hardware .......................................................................................................................... 13 

Software ........................................................................................................................... 13 

System requirements ............................................................................................................. 13 

Hardware .......................................................................................................................... 13 

Software ........................................................................................................................... 13 

Installation ........................................................................................................................... 14 

Starting CDGFix 3 Super ........................................................................................................ 14 

To start CDGFix 3 Super ...................................................................................................... 14 

Using CDGFix 3 Super............................................................................................................... 15 

Using CDGFix 3 Super ............................................................................................................ 15 

Screen layout ....................................................................................................................... 15 

Screen layout ..................................................................................................................... 15 

Main window ...................................................................................................................... 16 

Instructions window (also known as Packets window) .............................................................. 16 

Player window .................................................................................................................... 18 

Thumbnails window ............................................................................................................ 19 

Project window ................................................................................................................... 19 

Main menu ........................................................................................................................... 21 

Main menu ........................................................................................................................ 21 

File ................................................................................................................................... 22 

View ................................................................................................................................. 29 

Play .................................................................................................................................. 39 

Channels ........................................................................................................................... 47 

Tools ................................................................................................................................ 49 



CDGFix 3 Super help 

iv 

Options ............................................................................................................................. 60 

Window ............................................................................................................................. 64 

Help ................................................................................................................................. 67 

Main Toolbar......................................................................................................................... 74 

Main statusbar ...................................................................................................................... 75 

Project menu ........................................................................................................................ 75 

Project menu ..................................................................................................................... 76 

Project .............................................................................................................................. 76 

Edit .................................................................................................................................. 86 

View ................................................................................................................................. 88 

Tools ................................................................................................................................ 91 

Project toolbar ...................................................................................................................... 97 

Project statusbar ................................................................................................................... 98 

Context menus ..................................................................................................................... 98 

Context menus ................................................................................................................... 99 

Thumbnails ........................................................................................................................ 99 

Instructions ..................................................................................................................... 101 

Player ............................................................................................................................. 102 

Project ............................................................................................................................ 102 

Dialogs .............................................................................................................................. 103 

Dialogs ........................................................................................................................... 103 

About CDGFix Super ......................................................................................................... 104 

Border Preset ................................................................................................................... 104 

Browse Available Disc Catalogs ........................................................................................... 105 

Browse For Folder ............................................................................................................. 105 

Change Channel ............................................................................................................... 106 

Change Color Index .......................................................................................................... 106 

Change Color RGB ............................................................................................................ 106 

Create New SuperCDG Library ............................................................................................ 106 

Create Songbook From Project ........................................................................................... 107 

Define Color Transparency ................................................................................................. 107 

Delete Project .................................................................................................................. 108 

Edit Track ........................................................................................................................ 108 

Error Message .................................................................................................................. 108 

Export Tracks ................................................................................................................... 108 

Find Duplicate Tracks ........................................................................................................ 112 

Find Track ....................................................................................................................... 112 

Format Title And Artist ...................................................................................................... 112 

freedb Select Server ......................................................................................................... 112 

freedb Server Map ............................................................................................................ 113 

HEX Editor ....................................................................................................................... 113 

Insert Packets .................................................................................................................. 113 

Jump To Position .............................................................................................................. 113 



Table Of Contents 

v 

License Key ..................................................................................................................... 113 

Load Color Table .............................................................................................................. 114 

Load Disc Tracks Info ........................................................................................................ 115 

Load Track Information ..................................................................................................... 116 

Load Track Information Wizard ........................................................................................... 119 

Memory Preset ................................................................................................................. 119 

Open File......................................................................................................................... 119 

Print ............................................................................................................................... 120 

Properties For Project ........................................................................................................ 120 

Properties For Track .......................................................................................................... 120 

Recover Instruction ........................................................................................................... 120 

Rename Project Track Files ................................................................................................ 120 

Save File As ..................................................................................................................... 120 

Save Track To SCDG File ................................................................................................... 121 

Scan CD+G File ................................................................................................................ 121 

Scroll Copy and Scroll Preset .............................................................................................. 121 

Select CD/DVD Drive ......................................................................................................... 122 

Select Channel ................................................................................................................. 122 

Select Channels ................................................................................................................ 122 

Select Colortable .............................................................................................................. 122 

Select Disc ...................................................................................................................... 123 

Select Instruction ............................................................................................................. 123 

Select SCDG Track ............................................................................................................ 123 

Select Track Title And Artist ............................................................................................... 123 

Select Workspace Name .................................................................................................... 123 

Settings .......................................................................................................................... 124 

Submit CD+G Disc To freedb .............................................................................................. 153 

Support: Make A Suggestion .............................................................................................. 154 

Support: Report A Problem/Bug .......................................................................................... 154 

Task Results Report .......................................................................................................... 154 

Tile Block Normal and Tile Block XOR ................................................................................... 154 

Timeline .......................................................................................................................... 159 

Track Tile ........................................................................................................................ 159 

View Current Colortable ..................................................................................................... 160 

Hotkeys ............................................................................................................................. 160 

How to ................................................................................................................................. 163 

How to .............................................................................................................................. 163 

Register your license key ...................................................................................................... 163 

Open a track for edit or play ................................................................................................. 163 

File Open......................................................................................................................... 163 

Project Window Load Track ................................................................................................ 163 

Repair with single steps and breakpoints ................................................................................ 164 

Cut graphics and/or music .................................................................................................... 164 



CDGFix 3 Super help 

vi 

Fix out-of-sync issues .......................................................................................................... 164 

Change colors ..................................................................................................................... 164 

Working with projects .......................................................................................................... 164 

Native CDGFix 3 Super projects .......................................................................................... 165 

CAVS SuperCDG libraries ................................................................................................... 165 

RSQ NEO+G libraries ........................................................................................................ 165 

Cue sheets ...................................................................................................................... 166 

CAVS INX menus .............................................................................................................. 166 

CAVS Songlist and Juke files .............................................................................................. 166 

CD+G discs ..................................................................................................................... 166 

Create a new project ........................................................................................................... 166 

Open an existing project ...................................................................................................... 167 

A single project with multiple CDs and DVDs ........................................................................... 167 

Configure a disc lookup catalog ............................................................................................. 167 

Load title, artist and other track information ............................................................................ 168 

Using freedb ....................................................................................................................... 168 

Submitting new or updated entries to freedb ........................................................................ 168 

ID3 tags - what, where and why ............................................................................................ 168 

Convert multiple tracks between different formats.................................................................... 169 

Rip a CDG disc .................................................................................................................... 169 

1. Load the disc into the Project window .............................................................................. 169 

2. Load titles and artist names for the tracks ........................................................................ 169 

3. Export the CD+G tracks to the format you need ................................................................ 169 

Create a CUE sheet for burning a CDG disc ............................................................................. 169 

Create a songbook .............................................................................................................. 170 

Backup and restore ............................................................................................................. 170 

Dual monitor system............................................................................................................ 170 

Cleanup ZIP-files ................................................................................................................. 170 

How to go CAVS .................................................................................................................... 171 

How to go CAVS .................................................................................................................. 171 

SuperCDG libraries .............................................................................................................. 171 

Creating a SuperCDG library .............................................................................................. 171 

SuperCDG discs .................................................................................................................. 172 

Rip a SuperCDG disc ............................................................................................................ 173 

Rip your SuperCDG disc..................................................................................................... 173 

1. Loading a SuperCDG disc into the Project ......................................................................... 173 

2. Exporting the tracks to a selected format ......................................................................... 173 

Create a self-loading SuperCDG DVD ..................................................................................... 173 

Rip a Karaoke  disc directly to a SuperCDG library .................................................................... 174 

INX menu .......................................................................................................................... 174 

Songlist.txt ........................................................................................................................ 175 

Convert encrypted NCG files ................................................................................................. 175 

Convert your NCG files ...................................................................................................... 175 



Table Of Contents 

vii 

1. Loading NCG files into the Project .................................................................................... 175 

2. Exporting the tracks to a selected format ......................................................................... 176 

Glossary ............................................................................................................................... 179 

Index ................................................................................................................................... 181 





 

1 

 
Welcome to the CDGFix 3 Super online help 

Thank you for choosing CDGFix 3 Super as your karaoke management tool. CDGFix 3 Super is the 
premier software to edit and repair karaoke songs, convert songs between different file storage formats, 
keep track of your songs, and much more. 

CDGFix Crew works hard to supply you with easy-to-use tools for the tasks you need to perform, and will 
continuously design and develop new features. 

The CDGFix 3 Super documentation is also available as a PDF document for download. 

The online help applies to the current version of CDGFix 3 Super. By default your copy of CDGFix 3 Super 
checks for updates weekly. You can manually check for new versions any time by selecting Check for 
new version now on the Options menu. When features are introduced and/or changed they will be 
marked like this: 

The following applies to CDGFix 3 Super version 3.4 and newer only 
 

 

 

 

This online help and documentation are currently under development. CDGFix 

Crew apologizes for any inconvenience and will continue to publish new 
information as it becomes available. Last update was published 6 October 2009. 

 

Comments, suggestions and other input regarding this online help can be posted in 
forum thread Online Help. 
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Disclaimer 

The people behind CDGFix 3 Super - also known as CDGFix Crew - does not condone or endorse piracy in 
any way. The CDGFix 3 Super software includes functions to read and/or write file and CD/DVD formats 
that may be copyrighted or in other ways are protected. In most countries copyright laws allow the 
original purchaser/owner to legally make one personal backup/copy for their own personal use. CDGFix 
Crew would like to stress that it is illegal to backup/copy a file or disc that you do not own (i.e. 
personally purchased). It is also illegal to backup/copy your own file or disc and give copies away. The 
legality of copying a file or disc for a friend (if he owns that particular file or disc) may also depend on 
your country's legislation concerning that matter. 

By using CDGFix 3 Super to backup/copy files or discs you also confirm your understanding of and 
agreement to this disclaimer. CDGFix Crew shall NOT be held responsible for the misuse of the CDGFix 3 
Super software. If you abuse CDGFix 3 Super for illegal purposes CDGFix Crew will not be held 

responsible for any action that may be taken against you as a result of your misuse. 
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here. 

 

Trademarks 

CDGFix and CDGFix 3 Super are trademarks of CDGFix Crew worldwide. Trademark registration is 
pending. 
Microsoft is a registered trademark of Microsoft Corporation in the United States and other countries. 
Windows is a registered trademark of Microsoft Corporation in the United States and other countries. 
CAVS is a trademark of CAVS USA Inc. 

SCDG is a registered trademark of CAVS USA Inc. 
RSQ is a trademark of RSQ Audio. 
NEO+G is a trademark of RSQ Audio. 
Philips is a registered trademark of Koninklijke Philips Electronics N.V. 
Other brand and product names are trademarks of their respective holders. 

 

Supported technologies 

CDGFix 3 Super depends on some third-party components to do parts of the work. The following is a list 
of software / libraries / technologies that keep CDGFix 3 Super going: 

 

 

The LAME library is one of the two MP3 encoders supported by CDGFix 3 Super. 

 

 

And BLADE is the other supported MP3 encoder. 

 

 

CDGFix 3 Super supports the use of freedb for loading information about the tracks on a CDG disc, as 

well as sending information about discs to freedb. 
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CDGFix 3 Super supports reading and writing ID3 tags version 1 and 2. The code used by CDGFix 3 
Super to handle ID3 tags are written by mathXpert. 

 

 

The libraries used by CDGFix 3 Super to read and write ZIP archives are Zip32 and UnZip32 provided by 
Info-ZIP. Steve McMahon at vbAccelerator has written an excellent interface to these two libraries. 

 

 

The error detection and correction technology used on CDG discs to protect the graphics are known as 
Reed Solomon. The Reed Solomon software used by CDGFix 3 Super is originally written by Phil Karn. 

 

 

CDGFix 3 Super relies on the MMC specification applied through the ASPI layer in order to access CD and 
DVD drives. The traditional ASPI layer only allows access to SCSI devices, while a lot of computers today 
are equipped with ATAPI drives. Thanks to the StarBurn SDK made available by Rocket Division 
Software, both SCSI and ATAPI drives can be accessed uniformly by CDGFix 3 Super. 

 

 
CDGFix 3 Super supports the use of different songbook programs (in CDGFix terminology known as Disc 

Lookup Catalogs) to load track info for CDG discs as well as tracks stored on HDD. Currently the 
following Disc Lookup Catalogs are supported: 

 Karaoke Song List Creator 

 KJ-Pro (both versions 1 and 2) 

 Music Book Deluxe 

 FastTracks V2 Songbook Creator  

In addition CDGFix 3 Super also supports the use of a CSV-file as Disc Lookup Catalog. If you have a 
songbook program other than the above mentioned that is capable of exporting a CSV-file you may still 

use it with CDGFix 3 Super. 

 



 

7 

 

 
Key Features 

CDGFix 3 Super has a wide range of functionality to help you organize and maintain your karaoke songs 
collection. Some of the key features include: 

 Red Book-compliant player 

 Modify graphics (change color, remove/insert blocks to adjust sync, etc.) 

 Repair damaged graphics (includes tools to help locate and fix bad spots with a minimum of 

effort, as well as advanced manual tools and a full HEX editor) 

 Timeline to assist in removing silence at the beginning and/or end of a song while maintaining 

graphics/music sync 

 Rip CD+G discs using software Error detection and correction, allowing you to use a wide range 
of CD/DVD drives 

 On the fly conversion between graphics formats (CDG, MCG, SuperCDG discs, NEO+G discs) as 

well as single-file archives (ZIP, BIN) 

 Add/modify ID3 tags (both version 1 and 2) on single files or in batch 

 Build SuperCDG libraries and INX menu files for CAVS players 

 Build NEO+G libraries for RSQ players 

 Use your favorite song book program to load song titles and artist names for your songs 

 Feature-rich Project manager to help organize your songs and create songbooks 

 

Please note that support for the RSQ formats M3G and NEO+G are available in CDGFix 3 

Super starting with version 3.5. 
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What's new 

To see what the latest version of CDGFix 3 Super is, and to keep track of the latest additions and new 
features, please visit the CDGFix website at http://www.cdgfix.com/features3x.html. 

To view the newest features and latest bugfixes of your current version of CDGFix 3 Super you can select 
What's new? and Bugfixes respectively on the Help menu. 
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Contacting CDGFix Crew 

 
Corporate headquarter 

The CDGFix Crew headquarter is located in Europe. 

Name:  CDGFix Crew  

World Wide Web:  http://www.cdgfix.com/ 

Office hours:  Monday to Friday 
8 am to 4 pm CET (Central European Time)  

 

 
Corporate headquarter 

The CDGFix Crew headquarter is located in Europe. 

Name:  CDGFix Crew  

World Wide Web:  http://www.cdgfix.com/ 

Office hours:  Monday to Friday 
8 am to 4 pm CET (Central European Time)  

 

 
Sales department 

Contact our sales department for questions regarding purchases and licensing. 

World Wide Web:  http://www.cdgfix.com/ 

Email:  mailto:sales@cdgfix.com  

Office hours:  Monday to Friday 
8 am to 4 pm CET (Central European Time)  

 

 

 
Technical Support 

If you need help with a specific issue or problem and cannot locate the required information in the online 

help we suggest that you visit our forums (see address below). You may also post your own questions on 
the forums. Alternatively, or if you don't find what you are looking for in the forums, you can contact 
support by email (see address below). 

If you experience errors while using CDGFix 3 Super we recommend we suggest you click on the Submit 
button in the message box that is displayed. This will take you to a new window that lets you send all the 
relevant information directly by email to our support department. This way we will get all the required 
information (license key, operating system details, call stack, etc.) and can respond quicker. You may 
also select Support and then Report a Problem/Bug on the Help menu directly. 

World Wide Web:  http://www.cdgfix.com/ 

User forums: http://www.cdgfix.com/board 

Email:  mailto:support@cdgfix.com 

Office hours:  Monday to Friday 
8 am to 4 pm CET (Central European Time)  

  

 

 
Submitting suggestions 
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In order to continue develop CDGFix 3 Super with features our users need we need input. By selecting 

Support and then Make a Suggestion on the Help menu you can enter your suggestion and send it 
directly to our support and development department. 

Please feel free to let us know what you need or think would be a nice feature. 
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Getting started 

 

 
System requirements 

The recommended hardware and software for running CDGFix 3 Super are as follows: 

Hardware 

The minimum hardware requirements are: 

CPU:  Pentium III or later  

Memory:  128MB or more 

Available disk 
space:  

60MB  

  

For reading CDG disc you will need a compatible CD-drive. 

Reading SuperCDG discs requires a DVD-drive. 

 

Software 

The minimum software requirements are: 

Operating 
System:  

Windows 2000, Windows XP or Windows 
Vista 

 

To use Disc Lookup Catalogs (songbook programs) to load track information CDGFix 3 Super requires 
MDAC 2.8 (or later). 

For reading CDG discs CDGFix 3 Super depends on ASPI being correctly installed, with the Nero AG ASPI 
ATAPI extension on top. 
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To use Disc Lookup Catalogs (songbook programs) to load track information CDGFix 3 Super requires 

MDAC 2.8 (or later). 

For reading CDG discs CDGFix 3 Super depends on ASPI being correctly installed, with the Nero AG ASPI 
ATAPI extension on top. 

 

 

 
Installation 

CDGFix 3 Super installation is based on a single executable. To install please do as follows: 

 Download the CDFix 3 Super installation package by using the link you received by email and 

save it on your computer. 

 Close all programs. 

 Doubleclick on the downloaded file CDGFix3Super.zip to open it. 

 In the window that is displayed, doubleclick on the file CDGFix3Super.exe to start the 

installation. 

 Follow the instructions on the screen.  

By default, CDGFix 3 Super is installed in the folder C:\Program Files\CDGFix Crew\CDGFix 3.X 
Super. 

 

 

 
Starting CDGFix 3 Super 

Once the installation is complete, you will see a CDGFix 3 Super icon on your desktop. 

To start CDGFix 3 Super 

 Doubleclick the CDGFix 3 Super icon. 

or 

 From the Start menu, select Programs - CDGFix Crew - CDGFix 3.x Super. 
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Using CDGFix 3 Super 

 
Using CDGFix 3 Super 

This chapter is intended to provide you with information on how to operate CDGFix 3 Super to perform 
the tasks you need. Here you will find basic information on how CDGFix 3 Super is structured and how 
the screen layout (workspace) is designed, as well as detailed descriptions on each menu item and 
dialog. 

 

Screen layout 

 

 
Screen layout 

The CDGFix 3 Super screen layout, as shown below, consists of a workspace with five windows by 
default: Main window, Instructions window, Player window, Thumbnails window and Project window. 
Each window (except for the main window) can be turned on and off by using the View menu. 

 

The windows can be docked to each other or the screen borders, or float separately from each other. 
Windows that are docked to each other and the main window will move along with the main window. 
Floating windows will not move when one of the other windows are moved. Also, docked windows will 
resize when one of the neighboring windows are resized, to stay docked. 

To move a window just point the cursor to the window's titlebar. When the cursor changes to a cross-

arrow  then click the left mouse button and drag the window. If the window is dragged towards the 

edge of one of the other CDGFix windows, or one of the screen borders, the dragged window will snap 
into place when close enough to indicate that it will dock if released there. 

If you have a Dual monitor system each of the windows can be dragged onto both monitors 
independently of each other. This allows for placing the player window on one monitor and the rest of the 
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windows on the other monitor. This way you may use one monitor for the singer, and have the 

administrative windows for yourself on the other monitor. 

Since you may want to use different workspace layouts depending on the task you are working on, 
CDGFix 3 Super has a feature to save and restore workspace layouts. On the Window menu you will find 
the items Save Workspace and Load Workspace. Using these menu items you can easily change between 
different workspace layouts, thereby always having the optimal windows arrangement readily available. 

 

 

 
Main window 

The main window of CDGFix 3 Super is always located at the top of the workspace. The main window 
consists of the Main menu, Main toolbar and Main statusbar. 

 

While the other CDGFix 3 Super windows can be turned on and off by the View menu, the main window 
is always visible. 

All windows that are currently docked will move along when the main window is moved. 

 

 

 
Instructions window (also known as Packets window) 

The Instructions window displays all the graphics instructions of the loaded track. 

 

The list contains four columns: 

 Time ; displays the time when each instruction will play on the form MM:SS.TTT where MM is 

minutes, SS is seconds and TTT is thousands of a second. 

 Channel ; the channel on which each instruction will play 

 Instruction ; the instruction name 
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 File Offset ; the file offset in bytes of the instruction in a CDG file 

For details about the different instructions please refer to The CDG graphics format. 

By right-clicking in the Instructions window a context menu will display. This context menu is identical to 
the Play menu. Left-click on an instruction to select it for further processing by an item on the Tools 
menu. Finally, a double-click on an instruction will position the track exactly before the selected 
instruction is about to execute and open one of the instruction edit dialogs. 

By default the Instructions window displays only playable instructions, i.e. not timing packets. This can 
be changed by selecting Filter Packets on the View menu. All valid, playable instructions are displayed in 
black as shown above. Other types of packets are displayed with different colors as shown below: 

 

 The packet at 00:01.170 shows a possibly lost instruction displayed in pale red 

 The packet at 00:01.180 shows a playable instruction that contains one or more errors in the 
arguments displayed in red 

 The packet at 00:01.203 shows a timing packet displayed in gray 

For details about the different instructions please refer to The CDG graphics format. 

Finally, the Instructions window can display different icons in front of the instructions as show below: 
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 The packet at 00:01.477 displays a checkmark to indicate that the instructions has been 

modified since the track was last saved 

 The packet at 00:01.487 displays a hand to indicate that a Breakpoint has been set at this 

instruction 

 The packets at 00:01.500 and 00:01.520 display a Selection start marker and end marker 
respectively 

 

 

 
Player window 

The Player window is where the graphics are displayed. 
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If you have a Dual monitor system you may drag the Player window onto the secondary monitor in order 
to keep the singer's screen separated from the administrative windows. 

By right-clicking in the Player window (or selecting Size on the View menu) you can select a fixed size for 
the graphics, or whether you want it to stretch to fill the available area. 

 

 

 
Thumbnails window 

The Thumbnails window display thumbnails of the currently loaded track. 

The thumbnails are generated based on certain criteria like use of the 
Memory Preset instruction and "silent" periods with no graphics update. For 
more information on the CDG instruction set please refer to The CDG 
graphics format. 

The criteria for generating thumbnails can be adjusted in the Settings dialog 
on the Thumbnails page. 

By right-clicking in the Thumbnails window a context menu will display with 
options to navigate or update the graphics. A left-click on one of the 
thumbnails will position the track where the selected thumbnail starts. 

 

 
Project window 

The Project window is used to manage groups of tracks as a single unit. In 
CDGFix terms such groups of tracks are called Projects. 
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By default the tracks list in the Project window displays the following columns: 

 # ; the index of the track in the current project 

 Disc ; the name of the disc the track belongs to 

 Track ; the track number on the source disc 

 Genre ; a classification of the track 

 Artist ; the name of the artist that performs the track 

 Title ; the title of the track 

 File ; the file on disc that stores the track 

 Path ; the location on disc where the track file is stored 

 Length ; the play length of the track displayed as MM:SS where MM is minutes and SS is 

seconds 

 Music ; the type of sound file associated with the track (can be MP3, WAV or empty) 

 Size ; the total size on disc for the track including both graphics and music 

 Created ; the date and time when the track was created (normally displays the graphics file 

creation date/time) 

 Modified ; the date and time when the track was last modified (normally displays the graphics 

file modification date/time) 

Which columns are shown can be changed by selecting Columns on the Project View menu. The order of 
the columns can be changed by clicking on a column and dragging it to a new position while holding the 
left mouse button down. CDGFix remembers the column configuration between each session. 

Sorting the tracks is done by clicking on the column header for the column to sort on. The first click sorts 
the list in ascending order by the selected column, and the next click on the same column header sorts 
the list in descending order. To sort on more than one column click on the column headers in order from 
least to most significant. I.e. if you want the tracks list sorted by disc name and then track number you 
first click on the track number columns header and then the disc name column header. 

Right-clicking on a track displays a context menu, while double-clicking on a track loads it into the 
player/editor. 

A single track is selected by left-clicking on it, while multiple tracks can be selected by holding the Shift 

and/or Ctrl buttons down while left-clicking. Selecting single or multiple tracks follows standard Windows 
selection principles. 

At the front of each track is displayed an icon to indicate the source and format of the track as follows: 

 The track consists of two separate files; a graphics file (CDG or MCG) and a sound file (MP3 or 
WAV) 

 The tracks is stored as a ZIP archive 

 The track is stored as a Binary image 

 The track is a stored on a CDG disc 

 The track is stored in a SuperCDG library 

 The track consists of two separate files; an encrypted graphics file (NCG) and a sound file (MP3 
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or WAV) 

 The track is a MCG.MP3 file where the graphics are embedded in the MP3 file  

 The MCG.MP3 format is support by CDGFix 3 Super version 3.4 and newer only: 

- Version 3.4 supports reading MCG.MP3 files 

- Version 3.4a supports reading and writing MCG.MP3 files 
 

 

 The track is a M3G file or a NEO+G library track 

 The M3G and NEO+G formats are support by CDGFix 3 Super from version 3.5 

 

 The track file is missing (the file may have been moved or deleted after the track reference was 
added to the project) 

 

An existing project is opened by selecting Open on the Project menu. The currently recognized project 
types are as follows: 

 Native CDGFix projects (files of type CFP) 

 SuperCDG libraries, stored SuperCDG disc or on hard drive (files of type DAT) 

 CDG disc 

 CAVS INX menus (files of type INX) 

 CAVS Songlists (files named songlist.txt) 

SuperCDG discs and CDG discs may also be loaded by selecting Load Disc on the Project menu. 

Native CDGFix projects and SuperCDG libraries (stored on hard drive only, not on DVD) can be updated 
as follows: (to create a new project just start adding tracks to the empty Project window) 

 Add single or multiple files by selecting Add File or Add Folder on the project menu 

 Remove the selected track(s) by selecting Remove Track on the project menu 

 Manually edit the information for the selected track(s) by selecting Edit Title/Artist on the project 
Tools menu 

 Automatically update track information for the selected or all tracks by selecting Load Title/Artist 

on the project tools menu 

The project tools menu offers many other functions as well to help you organize tracks and modify track 
information. Please refer to the project Tools menu for more details. 

 

Main menu 

 

 
Main menu 

The main menu is located in the Main window, at the top of the CDGFix 3 Super workspace: 
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File 

 

File 

 

 

 

 

Open 

Located on File 
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menu: 

Shortcut key: Ctrl O 

Enabled when: Always 

Dialog 

displayed: 

Open File, Select SCDG Track 

Toolbar 
button: 

 

 

Loads a track into the player / editor. If Autoplay is enabled (see General settings for details) the track 
will start to play immediately. When loaded the track will be added to the Most Recently Used files list. 

Some of the supported track formats store groups of songs (i.e. SuperCDG disc). When a multiple-song 
repository is opened you will be prompted with a new dialog to select a single track. For a list of 
supported track formats please refer to Supported file formats. 

If a track is loaded and has been modified you will be prompted to save or discard the changes before 
the new track is loaded. 

When a track is loaded CDGFix 3 Super can make a backup copy. This backup copy can be restored on 
demand if you make changes to the track you want to roll back. Please refer to Backup settings for 
details. 

 

 

Save 

Located on 
menu: 

File 

Shortcut key: Ctrl S 

Enabled when: A track is loaded in the player / editor 

Dialog 

displayed: 

None 

Toolbar 
button: 

 

 

Saves the currently loaded track to its original storage. 

Note that some track formats are read-only (see Supported file formats for details). If the currently 
loaded track is of a read-only format, or if the track storage on disk is read-only, File Save will instead 
invoke File Save As to let you select another format / storage. 

 

 

 

Save As 

Located on 
menu: 

File 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor 

Dialog 
displayed: 

Save File As, Save Track To SCDG File 
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Toolbar 
button: 

 (select the drop-down arrow and then Save As) 

 

Saves the currently loaded track to another format and/or to a new storage location. When saved the 
new track location will be added to the Most Recently Used files list. 

Some of the supported track formats store groups of songs (i.e. SuperCDG libraries). When a multiple-
song repository is selected for saving the track you will be prompted with a new dialog to select storage 

in the repository. For a list of supported track formats please refer to Supported file formats. 

If another format is selected than the original track format CDGFix 3 Super will take the required actions 
to convert from the original to the new track format. This provides a simple way for converting single 
tracks from one format to another, but becomes cumbersome if you need to convert many tracks. For 
converting multiple tracks between different formats you should consider using batch conversion instead. 

 

 

Close 

Located on 
menu: 

File 

Shortcut key: Shift F4 

Enabled when: A track is loaded in the player / editor 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Closes the currently open track. If the track has been modified you will be prompted to save or discard 
the changes before the track is closed. 

 

 

 

Load Block 

Located on 

menu: 

File 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

Open File 

Toolbar 
button: 

None 

 

Loads a graphics block from the selected CDB file. The block has previously been saved using Save 
Block. 

The selected block is loaded into the currently open track starting at the current position, replacing as 
many instructions as are present in the loaded block. Before inserting the block you will be presented 
with the length of the block to load and the position where the block will be inserted. If you confirm the 
operation CDGFix 3 Super will insert the block as described. 
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Note: 

To avoid unpredictable results you should ensure that the loaded block does not replace instructions in a 
sequence of instructions that depend on each other, unless that is exactly what you intend to do. 

When working with blocks it is a good idea to have a general understanding of The CDG graphics format. 

 

 

 

Save Block 

Located on 
menu: 

File 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor and a Selection exists 

Dialog 
displayed: 

Save File As 

Toolbar 
button: 

None 

 

Saves the current Selection as a CDB file. The saved block can be loaded into the same, or another, track 
at a later time using Load Block. 

A block is a sequence of instructions that creates a defined graphics image. Block are useful for copying a 
piece of graphics, preferably error-free, to replace an identical graphics that contains errors. Often tracks 

from the same manufacturer shares a common intro and ending graphics, as well as graphics in the 
middle to denote instrumental sections. If a track contains heavy errors in such a graphics it may be 
simpler to copy it from another track than manually correcting the errors. 

To mark the starting and ending instructions of the graphics to save as a block you can use Selection 
Mark. However, often the Thumbnails window is easier to use since it groups distinct sets of instructions 
as blocks. If you find the block you need in the Thumbnails window simply right-click the block and select 
Save Block. 

 

Note: 

To make sure the block creates exactly the same graphics when inserted at another location or in 
another track, you should verify that the block contains Load Color Table and Memory Preset instructions 
before any Tile Block instructions. By doing so the Tile Block instructions will have the same starting 
point in the inserted block as in the original one. 

When working with blocks it is a good idea to have a general understanding of The CDG graphics format. 

 

Restore 

 

 

Restore 
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The items on the File Restore menu give you the option to restore the currently loaded track to the state 
it was before it was modified. 

 

 

 

Version On Disk 

Located on 
menu: 

File Restore 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Reloads the currently loaded track, discarding any modifications made after the track was last loaded or 
saved. You will be prompted to confirm discarding the modifications before the track is reloaded. 

 

 

 

Last Backup 
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Located on 
menu: 

File Restore 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Restores the last backup (if available) of the currently loaded track and reloads the track, discarding any 
modifications made after the track was last backed up. You will be prompted to confirm discarding the 
modifications before the backup is restored and the track reloaded. 

For details about track backups please refer to Backup settings. 

 

 

 

Backup Now 

Located on 
menu: 

File 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Backs up the currently loaded track. If a backup of the track already exists you will be prompted to 
replace or keep the existing backup. 

For details about track backups please refer to Backup settings. 

 

 

 

Print 

Located on 
menu: 

File 

Shortcut key: Ctrl P 

Enabled when: A track is loaded in the player / editor 

Dialog 
displayed: 

Print 

Toolbar 
button: 

None 

 

Prints the currently displayed graphics. 
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Export 

Located on 
menu: 

File 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor 

Dialog 

displayed: 

Save File As 

Toolbar 
button: 

None 

 

Saves the currently displayed graphics to a file. 

 

 

 

Most Recently Used files 

Located on 
menu: 

File 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 

button: 
 (select the drop-down arrow to display the most-recently-used files list) 

 

The most-recently-used (MRU) files list displays the last used tracks. The number of items displayed in 
the list defaults to four, but can be changed in MRU File Lists settings. 

Simply click on the track you want to load and CDGFix 3 Super will handle it as if you had used File Open 
and selected the track. 

 

 

 

Exit 

Located on 
menu: 

File 

Shortcut key: Alt F4 

Enabled when: Always 

Dialog 
displayed: 

None 
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Toolbar 
button: 

None 

 

Exits CDGFix 3 Super. If you have any unsaved changes, like a modified track or project, you will be 
prompted to save or discard these changes before CDGFix 3 Super exists. 

When CDGFix 3 Super exists the current workspace layout will be saved. The next time CDGFix 3 Super 
is started the workspace layout will be restored. 

 

View 

 

View 

 

 

 

 

Player 

Located on 
menu: 

View 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 
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Toggles the Player window visibility on and off. The current visibility of the window is indicated by a 
checkmark in front of the menu item. 

For details about working with workspace layouts please refer to Screen layout. 

 

 

 

Project 

Located on 
menu: 

View 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 

button: 

None 

 

Toggles the Project window visibility on and off. The current visibility of the window is indicated by a 
checkmark in front of the menu item. 

For details about working with workspace layouts please refer to Screen layout. 

 

 

 

Packets 

Located on 

menu: 

View 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Toggles the Instructions window visibility on and off. The current visibility of the window is indicated by a 
checkmark in front of the menu item. 

For details about working with workspace layouts please refer to Screen layout. 

 

 

 

Thumbnails 

Located on View 
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menu: 

Shortcut key: None 

Enabled when: Always 

Dialog 

displayed: 

None 

Toolbar 
button: 

None 

 

Toggles the Thumbnails window visibility on and off. The current visibility of the window is indicated by a 
checkmark in front of the menu item. 

For details about working with workspace layouts please refer to Screen layout. 

 

 

 

Toolbar 

Located on 
menu: 

View 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Toggles the Main toolbar visibility on and off. The current visibility of the toolbar is indicated by a 
checkmark in front of the menu item. 

 

 

 

Statusbar 

Located on 
menu: 

View 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Toggles the Main statusbar visibility on and off. The current visibility of the statusbar is indicated by a 
checkmark in front of the menu item. 
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Size 

 

Size 

 

 

The items on the View Size menu controls the size of the graphics in the Player window. 

The currently selected graphics size is indicated by a checkmark in front of the corresponding menu item. 

 

 

 

nnn% 

Located on 
menu: 

View Size 

Shortcut key: Ctrl F1, Ctrl F2, Ctrl F3, Ctrl F4, Ctrl F5 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

The View Size sub-menu contains the items 100%, 200%, 300%, 400% and 500%. Each item sets size 
of the graphics displayed in the Player window to the selected percentage of the original size. 
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If the selected graphics size is to large to fit in the current size of the Player window horizontal and 

vertical scrollbars will be displayed. 

The graphics many also be sized to Fit or to Full Screen. 

 

 

 

Fit 

Located on 
menu: 

View Size 

Shortcut key: Shift F1 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

This items scales the graphics displayed in the Player window to fit exactly into the current window size. 
The graphics will not be distorted, meaning the if the aspect ration of the Player window does not match 
the graphics ratio a black border will be displayed at top/bottom or left/right. The graphics will 

automatically resize when the Player window is resized. 

 

 

 

Full Screen 

Located on 
menu: 

View Size 

Shortcut key: Shift Ctrl F1 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Resizes the Player window to fit the available screen space. If you have a Dual monitor system the Player 
window will be resized to fit the monitor on which it is currently displayed. Using the Full Screen feature 
in combination with a Dual monitor system allows you maximize the Player window on the singers screen 

while you work with the other CDGFix 3 Super windows on your own monitor. 

To revert from full screen display you have several possibilities: 

 Select the Full Screen menu item once again 

 Use the key combination Shift Ctrl F1 

 Use the key combination Shift Esc 

If the Player window is maximized when you exit CDGFix 3 Super it will be restored to it's previous size 
and position the next time you start CDGFix 3 Super (i.e. CDGFix 3 Super will never start with the Player 
window maximized). 
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By selecting the Auto Full Screen On Play option found on the General page of the Settings dialog CDGFix 

3 Super will automatically maximize the Player window when a track starts to play and restore the Player 
window to it's normal position when the track ends. When working with a single monitor system this will 
help you maximize the Player window for your singer during a song and get back to the other windows 
after the song without having to manually switch back and forth. 

 

 

 

Border 

Located on 
menu: 

View 

Shortcut key: Ctrl B 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Toggles the visibility of the graphics border in the Player window. During normal playback of tracks the 
graphics border should be invisible. 

In The CDG graphics format the graphics are defined by a grid of 18 rows by 50 columns. The top and 
bottom rows and left and right columns are used for creating graphics that can be scrolled smoothly into 
view. Hence if you play a track that uses scrolling with the border visible you will see "garbage" along the 

edges that pops forth and back. 

However, when repairing a track that uses scrolling it can be useful to view the border. If the graphics 
that are scrolled into view are erroneous the only option to fix the tile is before it is scrolled in place, i.e. 
while it is still located in the border. 

 

 

 

Jump To 

Located on 
menu: 

View 

Shortcut key: Shift Ctrl F9 

Enabled when: A track is loaded in the player / editor and is paused / stopped / stopped 

Dialog 
displayed: 

Jump To Position 

Toolbar 
button: 

None 

 

Allows you to position the currently loaded track at a given time frame or instruction. Please refer to the 
displayed dialog for details. 

 

Filter Packets 
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Filter Packets 

 

 

The items on the View Filter Packets sub-menu allows you to select which packets are displayed in the 
Instructions window. The currently displayed packet types are indicated by checkmarks in front of the 
corresponding menu items. 

 

 

 

Instructions Only 

Located on 
menu: 

View Filter Packets 

Shortcut key: Ctrl D 

Enabled when: A track is loaded in the player / editor 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Selects all instruction packets to be displayed in the Instructions window. Selects Valid Instructions and 
Invalid Instructions, and de-selects Possibly Lost Instructions and Timing Packets. 

For details about how different packet types are displayed please refer to Instructions window. 
Information about the actual packet types themselves can be found in The CDG graphics format. 
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All Packets 

Located on 
menu: 

View Filter Packets 

Shortcut key: Ctrl A 

Enabled when: A track is loaded in the player / editor 

Dialog 
displayed: 

None 

Toolbar 

button: 

None 

 

Selects all packets to be displayed in the Instructions window. Selects Valid Instructions, Invalid 
Instructions, Possibly Lost Instructions and Timing Packets. 

For details about how different packet types are displayed please refer to Instructions window. 
Information about the actual packet types themselves can be found in The CDG graphics format. 

 

 

 

Valid Instructions 

Located on 
menu: 

View Filter Packets 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Toggles the display in the Instructions window of all packets containing a valid instruction with valid 
arguments. The visibility of these packets are indicated by a checkmark in front of the menu item. 

For details about how different packet types are displayed please refer to Instructions window. 
Information about the actual packet types themselves can be found in The CDG graphics format. 

 

 

 

Invalid Instructions 

Located on 
menu: 

View Filter Packets 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor 



Using CDGFix 3 Super 

37 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Toggles the display in the Instructions window of all packets containing a valid instruction but with invalid 
arguments. The visibility of these packets are indicated by a checkmark in front of the menu item. 

For details about how different packet types are displayed please refer to Instructions window. 
Information about the actual packet types themselves can be found in The CDG graphics format. 

 

 

 

Possibly Lost Instructions 

Located on 
menu: 

View Filter Packets 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Toggles the display in the Instructions window of all packets containing a valid instruction code but 
marked as a non-instruction packet. The visibility of these packets are indicated by a checkmark in front 
of the menu item. 

For details about how different packet types are displayed please refer to Instructions window. 
Information about the actual packet types themselves can be found in The CDG graphics format. 

 

 

 

Timing Packets 

Located on 
menu: 

View Filter Packets 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Toggles the display in the Instructions window of all packets marked as non-instruction packets. The 
visibility of these packets are indicated by a checkmark in front of the menu item. 

For details about how different packet types are displayed please refer to Instructions window. 
Information about the actual packet types themselves can be found in The CDG graphics format. 
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Refresh 

Located on 
menu: 

View 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 

displayed: 

None 

Toolbar 
button: 

None 

 

Refreshes the graphics display. May be useful when you have modified one or more instructions and the 
display is out of sync. 

 

 

 

Next Packet 

Located on 
menu: 

View 

Shortcut key: F2 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

Border Preset, Define Color Transparency, Load Color Table, Memory Preset, Scroll 
Copy and Scroll Preset, Tile Block Normal and Tile Block XOR 

Toolbar 
button: 

 

 

Displays a dialog for viewing and possibly modifying the next instruction about to be played. The actual 
dialog displayed depends on the instruction in question. The next instruction is indicated by the 
highlighted packet in the Instructions window. 

Please refer to the different dialogs for details about how to view and modify the different instructions. 

 

 

 

Current Colortable 

Located on 
menu: 

View 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog View Current Colortable 
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displayed: 

Toolbar 
button: 

None 

 

Displays the color table currently in effect. May be useful to detect where bad spots in the graphics 
origins from. 

 

 

 

HEX Editor 

Located on 
menu: 

View 

Shortcut key: Shift F2 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

HEX Editor 

Toolbar 
button: 

None 

 

Open up the HEX editor dialog, positioned at the current instruction packet. The HEX Editor dialog allows 
you to edit packets on a byte-by-byte basis instead of using the specific dialogs for each type of 
instruction. Please refer to the HEX Editor dialog for details. 

 

Play 

 

Play 
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Start 

Located on 
menu: 

Play 

Shortcut key: F5 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

None 

Toolbar 
button: 

 

 

Starts playing the loaded song from it's current position (i.e. from the beginning if the song has just been 
loaded). 

 

 

 

Restart 

Located on 
menu: 

Play 

Shortcut key: Shift F5 
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Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Rewinds the loaded song to the beginning and starts playing immediately. 

 

 

 

Pause 

Located on 
menu: 

Play 

Shortcut key: F4 

Enabled when: A track is loaded in the player / editor and is playing 

Dialog 
displayed: 

None 

Toolbar 
button: 

 

 

Pauses the currently playing song. Playing can be resumed at the current position by selecting Play Start. 

 

 

 

Stop 

Located on 
menu: 

Play 

Shortcut key: F6 

Enabled when: A track is loaded in the player / editor and is playing. 

Dialog 
displayed: 

None 

Toolbar 
button: 

 

 

Stops the currently playing song and rewinds it to the beginning. 

 

 

 

Single Step 

Located on 
menu: 

Play 
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Shortcut key: F8 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

None 

Toolbar 
button: 

 

 

Plays the next single packet. Used to play one packet at a time to locate an error (bad spot) in the 
graphics. 

 

 

 

Single Step Back 

Located on 
menu: 

Play 

Shortcut key: Shift F8 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

None 

Toolbar 
button: 

 

 

Rewinds the graphics by one single packet. Used in conjunction with Play Single Step to step back and 

forth around an error (bad spot) in the graphics to locate the faulty instruction. 

 

 

 

Fast Forward 

Located on 
menu: 

Play 

Shortcut key: Shift Ctrl F5 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

None 

Toolbar 
button: 

 

 

Starts playing the loaded song from the current position. The song is played at a higher speed than 
normal, and without sound. Can be used to browse quickly through a song to look for errors (bad spots) 
in the graphics. 

 

 

 



Using CDGFix 3 Super 

43 

Rewind 

Located on 
menu: 

Play 

Shortcut key: Alt Backspace 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

None 

Toolbar 
button: 

 

 

Rewinds the loaded song to the beginning. 

 

Play What 

 

 

Play What 

 

 

The items on the Play What submenu are used to select which packets are played in addition to valid 
instruction packets. The currently selected playing options are indicated by a checkmark to the left of the 

menu items. 

Including/excluding certain types of packets can help in locating errors (bad spots) in the graphics. 
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Normal 

Located on 
menu: 

Play What 

Shortcut key: None 

Enabled when: No song is playing. 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Selects normal playback of the graphics. In addition to valid instruction packets (which are always 
played) this includes Invalid Instructions and Timing Packets. 

 

 

 

Invalid Instructions 

Located on 
menu: 

Play What 

Shortcut key: None 

Enabled when: No song is playing. 

Dialog 

displayed: 

None 

Toolbar 
button: 

None 

 

Toggles playing of packets containing invalid instructions. Invalid instructions are packets with a valid 
instruction code but invalid instruction arguments. 

For details on packets, instruction codes and arguments please refer to The CDG graphics format. 

 

 

 

Possibly Lost Instructions 

Located on 

menu: 

Play What 

Shortcut key: None 

Enabled when: No song is playing 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 
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Toggles playing of packets containing possibly instructions. Possible lost instructions are packets with a 
valid instruction code that are marked as non-instruction packets. Including these packets may help to 
determine whether they actually are lost instructions. 

For details on packets, instruction codes and arguments please refer to The CDG graphics format. 

 

 

 

Timing Packets 

Located on 

menu: 

Play What 

Shortcut key: None 

Enabled when: No song is playing 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Toggles playing of timing packets. Timing packets are not actual instructions but are used to control the 

tempo of the graphics. By excluding timing packets the graphics will play with a constant speed of 300 
instructions pr. second. Makes it possible to scan faster through the graphics without having to wait for 
instrumental breaks etc. 

When timing packets are excluded the graphics and music will come out of sync so you may want to 
Mute the sound. 

For details on packets, instruction codes and arguments please refer to The CDG graphics format. 

 

 

 

Toggle Breakpoint 

Located on 
menu: 

Play 

Shortcut key: F9 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

None 

Toolbar 
button: 

 

 

Toggles a breakpoint at the selected packet in the Instructions window. A breakpoint is indicated by a  
to the left of the packet. All active breakpoints can be cleared by the Clear All Breakpoints command. 

For details and tips on working with breakpoints to locate and repair errors (bad spots) in the graphics 
please refer to Repair with single steps and breakpoints. 
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Clear All Breakpoints 

Located on 

menu: 

Play 

Shortcut key: Shift F9 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Clears all active breakpoints set by the Toggle Breakpoint command. 

For details and tips on working with breakpoints to locate and repair errors (bad spots) in the graphics 
please refer to Repair with single steps and breakpoints. 

 

 

 

Set Next Packet 

Located on 
menu: 

Play 

Shortcut key: Ctrl F9 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

None 

Toolbar 

button: 
 

 

Positions the current player position at the selected packet in the Instructions window. When playing is 
resumed with the Start command playing will start with the selected packet. 

 

 

 

Show Next Packet 

Located on 
menu: 

Play 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

None 

Toolbar 
button: 
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Highlights in the Instructions window the packet with which playing will begin when resumed by the Start 

command. 

 

Channels 

 

Channels 

 

 

The Channels menu is used to control which channels are active during playback. For more information 
about channels please refer to The CDG graphics format. 

 

 

 

Channel n 

Located on 

menu: 

Channels 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 
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The Channels menu items Channel 0 to Channel 15 toggles each channel on and off. When a channel is 

active a checkmark is placed to the left of the corresponding menu item. 

Detailed information about channels can be found in The CDG graphics format. 

 

 

 

All On 

Located on 
menu: 

Channels 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Turns all channels on. 

Detailed information about channels can be found in The CDG graphics format. 

 

 

 

All Off 

Located on 
menu: 

Channels 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Turns all channels off. 

Detailed information about channels can be found in The CDG graphics format. 

 

 

 

Select 

Located on 
menu: 

Channels 

Shortcut key: None 



Using CDGFix 3 Super 

49 

Enabled when: Always 

Dialog 
displayed: 

Select Channels 

Toolbar 
button: 

None 

 

Opens the Select Channels dialog for selection of active channels. 

Detailed information about channels can be found in The CDG graphics format. 

 

Tools 

 

Tools 

 

 

 

 

Undo 

Located on 

menu: 

Tools 
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Shortcut key: Ctrl Z 

Enabled when: Actions are available for undo 

Dialog 
displayed: 

None 

Toolbar 
button: 

 

 

Undoes the last action. All operations that affect the graphics or the music are saved on an actions stack. 
If you regret one or more actions you can easily undo them. 

NB! The actions stack is by default cleared when the track is saved. This behaviour can be changed on 
the General page in the Settings dialog. 

By clicking on the drop down arrow  to the right of the  on the toolbar you have the option of 

undoing several actions in one operation. The drop down arrow will display a small window showing the 
actions stack, and dragging the mouse up and down in this window will select more or fewer actions to 
undo. 

 

 

 

Redo 

Located on 
menu: 

Tools 

Shortcut key: None 

Enabled when: Actions are available for redo 

Dialog 
displayed: 

None 

Toolbar 
button: 

 

 

Redoes the last undone action. All operations that affect the graphics or the music are saved on an 
actions stack. If you regret having undone one or more actions you can easily redo them again. 

NB! The actions stack is by default cleared when the track is saved. This behaviour can be changed on 
the General page in the Settings dialog. 

By clicking on the drop down arrow  to the right of the  on the toolbar you have the option of 

redoing several actions in one operation. The drop down arrow will display a small window showing the 
actions stack, and dragging the mouse up and down in this window will select more or fewer actions to 
redo. 

 

 

 

Recover Instruction 

Located on 

menu: 

Tools 

Shortcut key: Ctrl R 

Enabled when: A track is loaded in the player / editor and is paused / stopped 



Using CDGFix 3 Super 

51 

Dialog 
displayed: 

Recover Instruction 

Toolbar 
button: 

None 

 

Recovers a lost instruction. A dialog is displayed showing a number of packets before and after the 
current track position. Please refer to the Recover Instruction dialog for details. 

 

 

 

Remove Instruction 

Located on 
menu: 

Tools 

Shortcut key: Ctrl M 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Removes the instruction selected in the Instructions window. The packet containing the instruction will 
not be physically removed, but merely marked as a non-instruction packet. 

You will be prompted to confirm the operation before the instruction is removed: 

 

If you confirm the instruction removal you will be prompted next to select how the instruction should be 

removed: 

 

The default answer, No, will just flag the packet as a non-instruction packet. Normally this is sufficient, 
and it retains the instruction code and arguments in the packet should you later want to restore the 
instruction. However, some PC CDG players ignores the instruction mark in packets and only tests the 
instruction code. If a valid instruction code is found the packet is played, giving unpredictable results. If 

you want to make sure the instruction is not played by any players you should fill the packet with zeroes 
by selecting Yes button. Selecting Cancel interrupts the operation and leaves the packet unmodified. 

Even if you fill the packet with zeroes it will be possible to Undo the instruction removal for as long as the 
operation is stored on the actions stack. Please refer to the Undo command for details on the actions 
stack lifetime. 
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Change Instruction 

Located on 
menu: 

Tools 

Shortcut key: Ctrl I 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

Select Instruction 

Toolbar 
button: 

None 

 

Changes the instruction code of the packet highlighted in the Instructions window. 

When editing an instruction packet by using the View Next Packet command only the arguments of the 
selected instruction packet can be modified, not the instruction code itself. To change the function of any 
given instruction packet you will use the Tools Change Instruction command. 

Select the new instruction code in the displayed dialog and click the OK button to update the packet. For 
details on instruction codes please refer to The CDG graphics format. 

 

 

 

Change Channel 

Located on 
menu: 

Tools 

Shortcut key: Ctrl C 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

Change Channel 

Toolbar 
button: 

None 

 

Changes any given channel to a selected channel. The change of channel is made for the entire file or the 
current Selection. Channel is a property of the Tile Block Normal and Tile Block XOR instructions, and the 

change of channel can be done for one instruction type only or for both. 

Please refer to the Change Channel dialog for details on changing channels. For details on channels and 
how they work please refer to The CDG graphics format. 

 

 

 

Insert Packet 

Located on 
menu: 

Tools 
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Shortcut key: None 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

Insert Packets 

Toolbar 
button: 

None 

 

Inserts the selected number of packets at the position highlighted in the Instructions window. You have 
the option of inserting timing packets or instruction packets. Please refer to the Insert Packets dialog for 
more details. 

Inserting timing packets at specific locations can be done to Fix out-of-sync issues, while inserting 
instruction packets will allow you to modify the graphics. For details on timing and instruction packets 
please refer to The CDG graphics format. 

 

 

 

Delete Packet 

Located on 
menu: 

Tools 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Deletes a single packet or the range of packets in the current Selection. Deleting packets at specific 
locations can be done to Fix out-of-sync issues. 

If there is no current selection you will be prompted to confirm deleting the packet currently highlighted 
in the Instructions window: 

 

If there is a current selection however you will instead be prompted to confirm removal of all the packets 
in the selection range: 
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Change Color RGB 

Located on 

menu: 

Tools 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

Change Color RGB 

Toolbar 
button: 

None 

 

Changes a single or multiple color table entry/entries, for one or more Load Color Table instructions. Can 

be used to change one color to another throughout the entire song or within a specified range. Please 
refer to the Change Color RGB dialog for details on how to replace color table entries. 

The Change Color RGB command modifies Load Color Table instructions by replacing color table entries 
with new RGB values, as opposed the Change Color Index command which modifies Tile Block 
instructions to use different color table indexes. Please refer to Change colors for more details about 
which method to use in different situations. 

 

 

 

Change Color Index 

Located on 
menu: 

Tools 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

Change Color Index 

Toolbar 
button: 

None 

 

Changes a color table index for all or a range of Tile Block instructions. Can be used to change one color 
to another throughout  the entire song or within a specified range or frame. Please refer to the Change 
Color Index dialog for details on how to replace color table indexes. 

The Change Color Index command modifies Tile Block instructions to use different color table indexes, as 
opposed the Change Color RGB command which modifies Load Color Table instructions by replacing color 
table entries with new RGB values. Please refer to Change colors for more details about which method to 
use in different situations. 

 

 

 

Scan Track 

Located on 
menu: 

Tools 



Using CDGFix 3 Super 

55 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

Scan CD+G File 

Toolbar 
button: 

None 

 

Scans the currently loaded track to detect errors, and possibly fix them. A fast and convenient method of 
finding errors, as well as fixing common errors that have a single solution. Please refer to the Scan CD+G 
File dialog more information on how to utilize this function. 

 

In CDGFix 3 Super versions prior to version 3.4b this menu item was named Scan File 
 

 

 

 

Track Tile 

Located on 
menu: 

Tools 

Shortcut key: Ctrl T 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

Track Tile 

Toolbar 
button: 

None 

 

Displays the Track Tile dialog that can assist you in locating the source of a bad spot in the graphics. By 
selecting the tile in the graphics where the bad spot is visible you will presented with a list of the Tile 
Block instructions that contribute to the selected tile. By simply highlighting each instruction in turn you 
will easily see which one that introduces the bad spot and hence need fixing.  

Please refer to the Track Tile dialog for more details on how to utilize this function. 

 

 

 

Copy Block 

Located on 
menu: 

Tools 

Shortcut key: None 

Enabled when: A track is loaded in the player / editor and is paused / stopped and a current 
Selection exists 

Dialog 

displayed: 

None 

Toolbar 
button: 

None 
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Copies the current Selection to the location starting with the packet highlighted in the Instructions 

window. The packets at the target location will be overwritten with the packets from the selection. To 
insert the selection at the new location without overwriting existing packets you may use the Insert 
Packet command to insert the correct number of packets before copying the selection. 

To insert the selection in an empty area (a section of the track with timing packets only) you can use the 
Filter Packets submenu on the View menu. 

The Copy Block command can be used to duplicate a set of instructions that create an intro screen or a 
pause screen (for an instrumental break), as well as copying an error-free sequence to another location 
to fix garbled graphics. 

 

 

 

Timeline 

Located on 
menu: 

Tools 

Shortcut key: Ctrl L 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

Timeline 

Toolbar 
button: 

None 

 

Display the Timeline dialog which presents a graphic diagram display of both the graphics and music. The 

Timeline is typically used to remove silence at the start and/or end of a song, as well as to adjust the 
graphics/music synchronization. Please refer to the Timeline dialog for more details. 

 

 

 

Browse Disc Catalogs 

Located on 
menu: 

Tools 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

Browse Available Disc Catalogs 

Toolbar 

button: 

None 

 

Allows you to search and browse the Configured disc lookup catalogs. If you have multiple disc lookup 
catalogs you can select which one to use, and then search, browse and export the available information 
for that catalog. 
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Detect CD/DVD drives 

Located on 
menu: 

Tools 

Shortcut key: None 

Enabled when: No track is playing 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Re-scans the ASPI layer to detect any changes in the CD/DVD drives since CDGFix 3 Super was last 
started. 

CDGFix 3 Super scans the ASPI layer at startup in order to save time by avoiding a CD/DVD drive scan 
each time you want to access a removable media. However, if you have external drives that were not 
powered on when CDGFix 3 Super was started you can use this command to avoid having to close and 
restart CDGFix 3 Super. 

When the re-scan has completed you will be presented with a dialog similar to the one below, showing 
the result of the re-scan as a list of detected CD/DVD drives: 

 

 

 

 

Search for Instruction 

Located on 
menu: 

Tools 

Shortcut key: Ctrl F 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

Select Instruction 

Toolbar 
button: 

None 

 

Searches for the first instruction packet containing the selected instruction, starting at the currently 
highlighted packet in the Instructions window. 

 

 



CDGFix 3 Super help 

58 

 

Search for Unknown Instruction 

Located on 

menu: 

Tools 

Shortcut key: Ctrl G 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Searches for the first instruction packet containing an unknown instruction, starting at the currently 

highlighted packet in the Instructions window. 

 

 

 

Search for Channel 

Located on 
menu: 

Tools 

Shortcut key: Ctrl H 

Enabled when: A track is loaded in the player / editor and is paused / stopped 

Dialog 
displayed: 

Select Channel 

Toolbar 
button: 

None 

 

Searches for the first Tile Block instruction packet playing on the selected channel, starting at the 
currently highlighted packet in the Instructions window. 

 

Selection 

 

 

Selection 
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A selection is a continuous section of packets. The selection is defined/modified by use of the Mark 
command, and can be cleared with the Clear command. 

Some commands requires a selection to operate on, while some commands either operate on the current 
selection if present and else operate on the entire track. 

The current selection is marked in the Instructions window with the  and  symbols (indicating the 
first and last packets of the selection, respectively). 

 

 

 

Mark 

Located on 
menu: 

Tools Selection 

Shortcut key: F3 

Enabled when: A track is loaded in the player / editor 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 
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Changes the Selection. Depending on the current selection state and the location of the currently 
highlighted packet in the Instructions window, the Mark command does one of the following: 

 

Current selection 
state 

Location of 
highlighted packet 

Action 

No selection Doesn't matter Highlighted packet 
is marked as 
selection start 

Only selection start is 

marked 

After current 

selection start 

Highlighted packet 

is marked as 
selection end 

 Before current 
selection start 

Current selection 
start is changed to 
selection end, and 
the highlighted 

packet is marked as 
selection start 

Selection start and 
end is marked 

Doesn't matter Current selection is 
cleared, and the 
highlighted packet 
is marked as start 

of a new selection 

 

 

 

Clear 

Located on 

menu: 

Tools Selection 

Shortcut key: Shift F3 

Enabled when: A track is loaded in the player / editor 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Clears the current Selection. 

 

Options 

 

Options 
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Mute 

Located on 
menu: 

Options 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 

button: 
 

 

Toggles sound during playback on and off. 

 

 

 

Reset Messageflags 

Located on 
menu: 

Options 

Shortcut key: None 

Enabled when: Always 
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Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Resets all message flags. In certain situations CDGFix 3 Super displays a message that has a "Do not 
show this message" or a "Do not ask me this question again" checkbox at the bottom. If this checkbox is 
selected before the message is confirmed or answered this particular message will not be displayed 
again. 

When the Reset Messageflags option is selected all messages that has previously been disabled will be 
shown again. 

 

Priority 

 

 

Priority 

 

 

The items on the Options Priority menu controls how CDGFix 3 Super will use the system resources. The 
default setting for priority is Normal which means CDGFix 3 Super will get an equal amount of CPU time 
as other running processes on the computer. However, in some situations you may want to favour 
CDGFix 3 Super over other applications, for example when you play songs, to avoid interruptions in the 
music or graphics. 
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Highest 

Located on 
menu: 

Options Priority 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Request maximum CPU usage for CDGFix 3 Super, meaning that other applications will only CDGFix 3 
Super idle periods. This ensures that CDGFix 3 Super will run uninterrupted for example during playback 
of a song. 

 

 

 

High 

Located on 
menu: 

Options Priority 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Request a higher CPU usage for CDGFix 3 Super than other applications, meaning that CDGFix 3 Super 
will perform more smoothly even when other applications are running. 

 

 

 

Normal 

Located on 
menu: 

Options Priority 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

This is the default setting for priority meaning that CDGFix 3 Super will get an equal amount of CPU time 
as other running processes on the computer. 
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Check for new version now 

Located on 
menu: 

Options 

Shortcut key: None 

Enabled when: Always 

Dialog 

displayed: 

None 

Toolbar 
button: 

None 

 

While CDGFix 3 Super by default checks for new versions once a week it is possible to disable this 
feature on the Upgrading page in the Settings dialog. If this feature has been disabled or if you want to 
check if a new version is available without waiting for the next automatic check, you can select this menu 
item. CDGFix 3 Super will then connect to the CDGFix server over the Internet and look for a newer 
version. 

 

 

 

Settings 

Located on 
menu: 

Options 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

Settings 

Toolbar 
button: 

None 

 

Opens the Settings dialog that is used to configure a variety of options that control how CDGFix 3 Super 
works. The Settings dialog is also used to manage Disc Catalogs, CAVS JB199 NCG Decryption, Email and 

other installation specific feature. 

 

Window 

 

Window 
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Dock Open Windows 

Located on 
menu: 

Window 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

This menu item will relocate all open windows (Player window, Project window, Thumbnails window, 
Instructions window) to their default positions relative to the Main window. Open windows are indicated 
by a checkmark in front of the window name on the View menu. 

Docking the open windows may be useful if they have been moved off screen or resized so they are 
invisible, or if you just want to restore the workspace to it's default layout. 

Other useful tools for managing the workspace layout and switching between different workspace layouts 
are the Load Workspace and Save Workspace items. 

 

 

 

Load Workspace 
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Located on 
menu: 

Window 

Shortcut key: None 

Enabled when: When one or more saved workspaces are available 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

This menu item will load the workspace layout defined by the selected sub-menu item. Workspace 
layouts are created/modified by using the Save Workspace item. 

For details about working with workspace layouts please refer to Screen layout. 

 

Save Workspace 

 

 

Save Workspace 

 

 

The items on the Windows Save Workspace menu give you the options of creating a new workspace 
layout or updating an existing workspace layout. 

If you select an existing workspace layout from the displayed sub-menu that workspace layout will be 
updated with the current windows positions. You will be prompted for confirmation before the selected 
workspace layout is actually modified. 

To create a new workspace layout from the current windows positions you will select New. 
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For details about working with workspace layouts please refer to Screen layout. 

 

 

 

New 

Located on 
menu: 

Window Save Workspace 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

Select Workspace Name 

Toolbar 
button: 

None 

 

Allows you to create a new workspace layout, or update an existing layout. Please refer to the dialog 
description for details. 

For details about working with workspace layouts please refer to Screen layout. 

 

 

 

Delete Workspace 

Located on 
menu: 

Window 

Shortcut key: None 

Enabled when: When one or more saved workspaces are available 

Dialog 

displayed: 

None 

Toolbar 
button: 

None 

 

Deletes the workspace layout identified by the selected sub-menu item. You will be prompted for 
confirmation before the selected workspace layout is actually deleted. 

For details about working with workspace layouts please refer to Screen layout. 

 

Help 

 

Help 
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Prior to CDGFix 3 Super version 3.4c the Help menu had the following layout 
 

 

 

 

 

CDGFix Home 
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Located on 
menu: 

Help 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Opens the CDGFix home page http://www.cdgfix.com in the internal browser. By holding down the Shift 
key your default internet browser will be launched instead. 

 

 

 

Contents 

Located on 
menu: 

Help 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Opens the CDGFix online help contents pane in the internal browser. By holding down the Shift key your 
default internet browser will be launched instead. 

 

In CDGFix 3 Super versions prior to version 3.4 this menu item is named 'Online Help' 
 

 

 

 

Index 

Located on 
menu: 

Help 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Opens the CDGFix online help index pane in the internal browser. By holding down the Shift key your 
default internet browser will be launched instead. 
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This menu item is available CDGFix 3 Super version 3.4 and newer only 
 

 

 

 

Search 

Located on 
menu: 

Help 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 

button: 

None 

 

Opens the CDGFix online help search pane in the internal browser. By holding down the Shift key your 
default internet browser will be launched instead. 

 

This menu item is available CDGFix 3 Super version 3.4 and newer only 
 

 

 

 

Samples 

Located on 
menu: 

Help 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Opens the CDGFix downloads page http://www.cdgfix.com/downloads.html in the internal browser. By 
holding down the Shift key your default internet browser will be launched instead. 

 

 

 

FAQ 

Located on 
menu: 

Help 
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Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Opens the CDGFix FAQ page http://www.cdgfix.com/faqs.html in the internal browser. By holding down 
the Shift key your default internet browser will be launched instead. 

 

 

 

Forum 

Located on 
menu: 

Help 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Opens the CDGFix forum at http://www.cdgfix.com/board in the internal browser. By holding down the 

Shift key your default internet browser will be launched instead. 

 

 

 

What's new? 

Located on 
menu: 

Help 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Opens the file History.html (located in the CDGFix 3 Super installation folder) in the internal browser. By 
holding down the Shift key your default internet browser will be launched instead. 

The topmost section of the file History.html describes the latest additions for your current version of 
CDGFix 3 Super. 
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Bugfixes 

Located on 

menu: 

Help 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Opens the file History.html (located in the CDGFix 3 Super installation folder) in the internal browser. By 

holding down the Shift key your default internet browser will be launched instead. 

The bottom section of the file History.html describes the latest additions for your current version of 
CDGFix 3 Super. 

 

Support 

 

 

Support 

 

 

The items on the Help Support menu provide features for submitting a suggestion or reporting a problem 
or bug to CDGFix Crew. 
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Make a Suggestion 

Located on 
menu: 

Help Support 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

Support: Make A Suggestion 

Toolbar 
button: 

None 

 

Opens the Support: Make A Suggestion dialog that can be used to submit a new feature or a functionality 
change to CDGFix Crew. 

 

 

 

Report a Problem/Bug 

Located on 
menu: 

Help Support 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

Support: Report A Problem/Bug 

Toolbar 
button: 

None 

 

Opens the Support: Report A Problem/Bug dialog that can be used to report a problem or bug to CDGFix 
Crew. 

 

 

 

Product Key 

Located on 
menu: 

Help 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

License Key 

Toolbar None 
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button: 

 

Opens the License Key dialog that is used to view your product key, and to enter your license key and 
personal information. 

 

 

About CDGFix 

Located on 
menu: 

Help 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

About CDGFix Super 

Toolbar 
button: 

None 

 

Opens the About CDGFix Super dialog. This dialog provides you with the current CDGFix 3 Super version 
and build numbers, as well as a link to the Microsoft Windows System Information application. 

 

 

 
Main Toolbar 

The main toolbar is located in the Main window, at the top of the CDGFix 3 Super workspace: 

 

 

The toolbar buttons are as follows: 

 File Open. By clicking on the down arrow  a menu with the Most Recently Used files will be 
displayed. 

 File Save. By clicking on the down arrow  a menu with Save and Save As will be displayed. 

 Play Rewind. 

 Play Start. 

 Play Fast Forward. 

 Play Pause. 

 Play Stop. 

 Play Single Step Back. 
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 Play Single Step. 

 Play Toggle Breakpoint. 

 Play Set Next Packet. 

 Play Show Next Packet. 

 View Next Packet. 

 Tools Undo. By clicking on the down arrow  a menu will display to allow for undo of multiple 
actions at once. 

 Tools Redo. By clicking on the down arrow  a menu will display to allow for redo of multiple 
actions at once. 

 Options Mute. When mute is on (i.e. no sound) the mute button will display like . 

 

The slider to the left of the mute button indicates the current position in the playing track. By dragging 
the slider the playback position will be adjusted accordingly. 

The slider to the right of the mute button is used to adjust the volume. 

 

 

 
Main statusbar 

The main statusbar is located in the Main window, at the top of the CDGFix 3 Super workspace: 

 

 

The main statusbar has seven panels as shown above. These panels are, from left to right, as follows: 

 Message display; displays messages for the operation currently in progress. 

 Progress display; displays the progress for the currently running operation. 

 Border; indicates whether the graphics display Border is visible or not by displaying the text 
Border in black or gray respectively. By double-clicking the Border panel the border is toggled on 

and off. 

 Current selection; displays the current graphics Selection. By double- or right-clicking the 
selection panel a popup menu is opened to allow manipulation of the selection. 

 CDG panel; displays the graphics play length of the currently loaded track. 

 Music panel; display the type (MP3 or WAV) play length of the currently loaded soundtrack. 

 Channel; by right-clicking this panel a popup menu for selection of currently playing channels is 
available. Equivalent to the Channels menu. Double-clicking the Channel panel opens the Select 
Channels dialog. 

 

Project menu 
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Project menu 

The project menu is located in the Project window: 

 

 

Project 

 

Project 



Using CDGFix 3 Super 

77 

 

 

 

 

New 

Located on 
menu: 

Project 

Shortcut key: Ctrl N 

Enabled when: Always 

Dialog 

displayed: 

Save File As 

Toolbar 
button: 

None 

 

Creates a new CDGFix 3 Super project. If the current project has been modified since it was opened or 
last saved you will be prompted whether to save or discard the changes, or cancel the New Project 
command. 

When creating a new project you can choose between to distinct project types; a native CDGFix 3 Super 
project (file type CFP) or a CAVS SuperCDG library (file type DAT). The project type is selected in the 
Save File As dialog that is displayed. In this dialog you also select the name of the new project and 
where to put the file(s). Native CDGFix 3 Super projects are by default saved in the CDGFix 3 Super 
subfolder Projects. 

A native CDGFix 3 Super project can hold tracks of any supported file format, and is a convenient way to 
group multiple tracks that you want to work with as a unit. Using the different project menu commands 

to operate on the project tracks you can: 

 Load title, artist and other track information from track filenames or a disc lookup catalog 
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 Reformat Title/Artist information 

 Rename Track Files 

 Convert tracks between different formats 

 Create CAVS SuperCDG libraries 

 Create CAVS INX menu or Songlist.txt 

 Write ID3 Tags to the tracks MP3-files 

A CDGFix 3 Super project can be created just by starting to drag tracks into the empty Project window 
(or by using the Add File and Add Folder commands on the Project menu) - i.e. you don't have to use the 
New command. Just add the tracks you want and then select Save As on the project menu. 

 

 

 

Open 

Located on 
menu: 

Project 

Shortcut key: Ctrl Q 

Enabled when: Always 

Dialog 

displayed: 

Open File 

Toolbar 
button: 

 

 

Displays the Open File dialog, allowing you to select and open an existing project. Currently CDGFix 3 
Super recognises the following project types: 

 Native CDGFix 3 Super projects (file type CFP) 

 CAVS SuperCDG libraries (file type DAT) 

 CUE sheets (file type CUE) 

 CAVS INX menus (file type INX) 

 CAVS Songlist.txt (file type TXT) 

CDGFix 3 Super also recognises a CDG karaoke disc (or a standard audio CD) as a project, but to load a 
CD into the Project window you will have to use the Load Disc command on the Project menu. The Load 
Disc command also recognises SuperCDG DVDs and data discs (CD or DVD) with file based tracks (like 
MP3+G). 

Please note that not all menu commands are valid for all project types. For example you cannot add or 
remove tracks from CUE sheets, INX menus and Songlist.txt projects. To modify these project types you 
must first save them as a native CDGFix 3 Super project using Save As on the project menu. Then you 
can modify the native project as you like, and finally rebuild the original project by using the Export 
Tracks command on the project menu. 

For more details on working with different project types please refer to Work with projects. 

 

 

 

Close 

Located on Project 
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menu: 

Shortcut key: Shift Ctrl F4 

Enabled when: A project is open 

Dialog 

displayed: 

None 

Toolbar 
button: 

None 

 

Closes the currently open project. If changes have been made to the project since it was opened or last 
saved you will be prompted whether to save or discard the changes, or cancel the Close command. 

 

 

 

Save 

Located on 
menu: 

Project 

Shortcut key: Ctrl W 

Enabled when: A project is open and is of a type that can be modified 

Dialog 
displayed: 

None 

Toolbar 
button: 

 

 

Saves any changes made to the current project. The changes are saved to the original project name and 
location, overwriting the original project definition. 

If the currently open project is of a type that cannot be modified directly you may convert the project to 
a native CDGFix 3 Super project or a CAVS SuperCDG project by using the Save As command instead. 

 

 

 

Save As 

Located on 
menu: 

Project 

Shortcut key: None 

Enabled when: A project is open 

Dialog 

displayed: 

Save File As 

Toolbar 
button: 

 (available on the drop down menu) 

 

Opens a dialog that allows you to save the currently open project with a new name and location and/or 
as another type, i.e. a native CDGFix 3 Super project (file type CFP) or a CAVS SuperCDG library (file 
type DAT). 
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Please refer to Working with projects and SuperCDG libraries for more details about the different 

formats, and when and how to use them. 

 

 

 

Delete 

Located on 
menu: 

Project 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

Open File 

Toolbar 
button: 

None 

 

Opens a dialog to select a native CDGFix 3 Super project that you want to delete. This command only 
deletes the project definition file (file type CFP), not the tracks that are referenced from the project. 

By default CDGFix 3 Super stores all native projects in the CDGFix 3 Super subfolder named Projects. 
This convention allows you manage and keep track of your native projects in an easy way. For more 
details about working with projects in CDGFix 3 Super - both native and other types - please refer to 
Working with projects. 

 

 

 

Write SuperCDG List.txt 

Located on 
menu: 

Project 

Shortcut key: None 

Enabled when: A SuperCDG library is loaded 

Dialog 

displayed: 

Save File As 

Toolbar 
button: 

None 

 

This command creates a CAVS List.txt file containing all the tracks in the currently open SuperCDG 
library. 

CDGFix automatically creates a List.txt file when a SuperCDG library is created or modified. The List.txt 
file is located in the same folder that holds the SuperCDG library DAT-files. For more details please refer 
to SuperCDG libraries. 

 

This menu item is available only in CDGFix 3 Super prior to version 3.5a. Starting with 

version 3.5a you can use the Create Indexfile menu item on the Project Tools menu 

instead. 
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Load Disc 

Located on 
menu: 

Project 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

Select CD/DVD Drive 

Toolbar 
button: 

 

 

Displays a dialog that lets you select a removable media to load into the Project window. The dialog 
displays the available CD/DVD drives on the system and the status for each drive (i.e. Not Ready or a 
media description like Audio CD, SuperCDG, etc.). For more details please refer to the Select CD/DVD 
Drive dialog description. 

A shortcut directly to each available CD/DVD drive is available by clicking on the drop down arrow  to 

the left of the  button. The drop down menu displayed has one item for each CD/DVD drive. 

When an audio CD (or Karaoke disc) is loaded CDGFix by default consults the freedb online media 
database to retrieve disc and track information. If only one single match is found this is accepted and the 
information is loaded into the Project window. If more than one match is found for the disc you will be 
prompted with the Select Disc dialog to choose the correct disc information. The freedb behaviour is 
controlled by the options on the freedb Lookup page in the Settings dialog. 

CDGFix by default loads a disc automatically when inserted into one of the CD/DVD drives, and the disc 
is automatically ejected when the project is closed. This behaviour can be controlled by selecting the 
various options on the CD/DVD-Drives / Reading page in the Settings dialog. 

Please note that the Load Disc command (and the Select CD/DVD Drive dialog) depends on the ASPI 
layer. Please refer to the ASPI description for more details and troubleshooting. 

 

 

 

Eject Disc in Drive 

Located on 
menu: 

Project 

Shortcut key: None 

Enabled when: When a CD/DVD is loaded 

Dialog 
displayed: 

None 

Toolbar 

button: 
 

 

Ejects the media in the CD/DVD drive that corresponds to the currently loaded project. 

By default CDGFix automatically ejects the corresponding media when the project is closed, and also 
closes the project when the corresponding media is manually ejected. This behaviour can be controlled 
by selecting the various options on the CD/DVD-Drives / Reading page in the Settings dialog. 
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Add File 

Located on 
menu: 

Project 

Shortcut key: Ctrl F7 

Enabled when: The current project can be modified 

Dialog 
displayed: 

Add Tracks 

Toolbar 
button: 

 

 

Displays the Add Tracks dialog to let you select one or multiple tracks to add to the current project, 
assuming that the project can be modified. Project types that cannot be updated are audio CD (Karaoke 
disc), CUE sheets (file type CUE), CAVS INX menus (file type INX), CAVS Songlist.txt projects (file type 
TXT), and SuperCDG libraries located on read-only removable media. Note that a SuperCDG library can 
be modified if it is first copied to the hard drive (see SuperCDG libraries for details). 

When adding tracks to a project CDGFix 3 Super attempts to read ID3 tags from each track's MP3 file (if 
applicable, i.e. if the track has a MP3 file). If ID3 tags are found the information contained there are 
loaded into the project entry for that track. 

If the project added to is a SuperCDG library (stored on hard drive in order to be modified) then the 
tracks will be compiled into the SuperCDG library on the fly. CDGFix 3 Super is also capable of replacing 
and deleting tracks in a SuperCDG library, making it simple to modify a SuperCDG library to suit your 

own taste. Please refer to SuperCDG libraries and Rip a Karaoke disc directly to a SuperCDG library for 
more details. 

Please refer to Working with projects for more details. 

 

 

 

Add Folder 

Located on 
menu: 

Project 

Shortcut key: Ctrl F8 

Enabled when: The current project can be modified 

Dialog 
displayed: 

Browse For Folder 

Toolbar 
button: 

 

 

Displays the Browse For Folder dialog, letting you select a folder from which CDGFix 3 Super will scan 
recursively for tracks to add to the current project. Each track found is treated as if it was added through 
the Add File command, with the same options and limitations. Please refer to this command for further 
details. 
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Remove Track 

Located on 
menu: 

Project 

Shortcut key: Del 

Enabled when: The current project can be modified, and one or more tracks are selected 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Deletes the currently selected track(s) from the current project, assuming that the project can be 
modified. Project types that cannot be updated are audio CD (Karaoke disc), CUE sheets (file type CUE), 
CAVS INX menus (file type INX), CAVS Songlist.txt projects (file type TXT), and SuperCDG libraries 
located on read-only removable media. Note that a SuperCDG library can be modified if it is first copied 
to the hard drive (see SuperCDG libraries for details). 

For a native CDGFix 3 Super project (file type CFP) only the track reference is removed; the physical 
track files are not deleted. Please note that you will NOT be prompted to confirm the delete operation. 

For a SuperCDG library the selected track(s) will be permanently deleted from the library, and can not be 
recovered. Before that track(s) are deleted you will be prompted to confirm the operation. 

For more information please refer to Working with projects. 

 

 

 

Load Track 

Located on 
menu: 

Project 

Shortcut key: None (you may press the Enter key while the focus is in the Project window) 

Enabled when: A track is selected in the Project window 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Loads the track currently selected in the Project window into the Player. Depending on the physical 
storage format of the track CDGFix 3 Super will automatically extract and/or convert/decrypt the track as 
required. 

If the selected track is located on a removable media that is not currently loaded into one of the CD/DVD 
drives, you will be prompted to insert the appropriate media to continue. 

If the Autoplay option has been set (can be done on the General page in the Settings dialog) then 
CDGFix 3 Super will automatically start playing the track once it is loaded. On the same settings page 

there is an Autoload option that when selected makes CDGFix 3 Super automatically load the next track 
from the project when the current track is finished. By selecting both of these options the project will act 
as a playlist, making CDGFix 3 Super play the tracks in turn with no user intervention. This behaviour, 
however, requires that all tracks are available from the hard drive. 
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Track Info 

Located on 
menu: 

Project 

Shortcut key: None 

Enabled when: One or more tracks are selected in the Project window 

Dialog 
displayed: 

Properties For Track 

Toolbar 
button: 

None 

 

Displays a dialog with information on the track currently highlighted in the Project window. 

 

 

 

Export Tracks 

Located on 
menu: 

Project 

Shortcut key: None 

Enabled when: A project is open 

Dialog 
displayed: 

Export Tracks 

Toolbar 
button: 

 

 

Using the Export Tracks dialog you can convert tracks between different formats, rip audio/Karaoke CDs, 
rip SuperCDG libraries, create CAVS INX menus, and build BIN-files with a corresponding CUE-sheet for 
CD burning. 

The Export Tracks command is one of the most powerful CDGFix 3 Super features and the heart of the 
format conversion options. For more details on the different possibilities please refer to the Export Tracks 

dialog documentation. 

 

 

 

Save Tracklist As CSV 

Located on 
menu: 

Project 

Shortcut key: None 

Enabled when: A project is open 

Dialog 
displayed: 

Save File As 

Toolbar 
button: 

 (available on the drop down menu) 

 



Using CDGFix 3 Super 

85 

This command lets you save the current project contents (all tracks) to a CSV formatted file. The first 

line of the resulting file contains columns headers, while the rest of the lines correspond to each track in 
the project. 

The columns in the file are separated by semicolon (;) and is readable by most spreadsheet programs as 
well as some songbook programs. 

 

 

 

Print 

Located on 
menu: 

Project 

Shortcut key: None 

Enabled when: A project is open 

Dialog 
displayed: 

None 

Toolbar 
button: 

 

 

Creates a formatted report of the current project tracks. The resulting report can be printed or saved to a 
file in PDF format. 

 

 

 

Properties 

Located on 

menu: 

Project 

Shortcut key: None 

Enabled when: A project is open 

Dialog 
displayed: 

Properties For Project 

Toolbar 
button: 

 

 

Displays a dialog with details about the currently open project. 

 

 

 

Most Recently Used files 

Located on 
menu: 

Project 

Shortcut key: None 

Enabled when: Always 
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Dialog 
displayed: 

None 

Toolbar 
button: 

 (select the drop-down arrow to display the most-recently-used projects list) 

 

The most-recently-used (MRU) projects list displays the last used projects. The number of items 
displayed in the list defaults to four, but can be changed in MRU File Lists settings. 

Simply click on the project you want to open and CDGFix 3 Super will handle it as if you had used Project 
Open and selected the project. 

 

Edit 

 

Edit 

 

 

The menu item Propagate Selection applies to CDGFix 3 Super version 3.6j and newer 

only 
 

 

 

 

 

Copy Tracklist as CSV 

Located on 
menu: 

Edit 

Shortcut key: Ctrl Ins 

Enabled when: One or more tracks are loaded in the Project window 

Dialog 
displayed: 

None 

Toolbar 
button: 
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Copies the currently selected tracks in the Project window to the Clipboard in CSV format. The result can 

be pasted into any program capable of reading CSV format with the TAB character as column separator. 

 

 

 

Clear 

Located on 
menu: 

Edit 

Shortcut key: Shift Delete 

Enabled when: One or more tracks are loaded in the Project window and the current project can be 
modified 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Removes all tracks from the Project window. 

Warning: You will not be prompted to confirm the Clear operation. The command is executed 
immediately. 

 

 

 

Select All 

Located on 
menu: 

Edit 

Shortcut key: None 

Enabled when: One or more tracks are loaded in the Project window 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Selects all tracks in the Project window. 

 

 

 

Select None 

Located on 
menu: 

Edit 

Shortcut key: None 

Enabled when: One or more tracks are loaded in the Project window 
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Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Clears any selection in the Project window (i.e. no track will be selected). 

 

 

 

Invert Selection 

Located on 
menu: 

Edit 

Shortcut key: None 

Enabled when: One or more tracks are loaded in the Project window 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Inverts the current selection in the Project window (i.e. selected tracks becomes unselected and vice 
versa). 

 

View 

 

View 
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Toolbar 

Located on 

menu: 

View 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Toggles the Project toolbar visibility on and off. The current visibility of the toolbar is indicated by a 

checkmark in front of the menu item. 

 

 

 

Statusbar 

Located on 
menu: 

View 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Toggles the Project statusbar visibility on and off. The current visibility of the statusbar is indicated by a 
checkmark in front of the menu item. 

 

Columns 

 

Columns 
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The items below the Fit Widths command corresponds to the available Project window columns, and can 
be used to show or hide selected columns. 

The currently visible columns are indicated by a checkmark to the left of each column name. 

 

 

 

Fit Widths 

Located on 
menu: 

View Columns 

Shortcut key: None 

Enabled when: One or more tracks are loaded in the Project window 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Adjust each visible column in the Project window to fit the current contents in the column. 

Columns can also be resized manually by pointing at the right edge of the column header, and then 
dragging the edge while holding the left mouse button down. 

The column widths are saved when CDGFix 3 Super is closed and restored the next time CDGFix 2 Super 
is started. 

 

 

 

Tracks List Columns 
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Located on 
menu: 

View Columns 

Shortcut key: None 

Enabled when: Always 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

Each available Project window column has a corresponding menu item to show or hide each individual 
column. A column's current visibility is indicated by a checkmark to the left of the corresponding menu 
item. 

The visibility of each column is saved when CDGFix 3 Super is closed and restored the next time CDGFix 
2 Super is started. 

 

Tools 

 

Tools 

 

 

 

 

Create Songbook 

Located on 
menu: 

Tools 

Shortcut key: None 

Enabled when: One or more tracks are loaded in the Project window 
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Dialog 
displayed: 

Create Songbook From Project 

Toolbar 
button: 

 

 

Opens the dialog that allows you to configure and create a songbook from the currently project. For more 
details on how to configure and create a songbook please refer to the Create Songbook From Project 
dialog. 

 

 

 

Find Track 

Located on 
menu: 

Tools 

Shortcut key: None 

Enabled when: One or more tracks are loaded in the Project window 

Dialog 
displayed: 

Find Track 

Toolbar 
button: 

 

 

Opens a dialog that allows you to search for a track based on the contents of one or more columns. 
Please refer to the Find Track dialog for more details on how to search. 

It is also possible to search for a track by using the search box on the Project toolbar. 

 

 

 

Find Duplicates 

Located on 
menu: 

Tools 

Shortcut key: None 

Enabled when: One or more tracks are loaded in the Project window 

Dialog 
displayed: 

Find Duplicate Tracks 

Toolbar 
button: 

None 

 

Opens the Find Duplicate Tracks dialog that helps you find duplicate tracks in the project. You can search 
the project for duplicates based on one or more of the columns Title, Artist and Disc name. If one or 
more duplicates are found a report presenting the duplicates will be created. 

When comparing two tracks to see whether they are duplicates CDGFix 3 Super uses an algorithm for 
string matching that do not require for example artist names to be spelled exactly identical to be 
considered the same. I.e. the three strings "Elvis Presley", "Elvis" and "Presley" will be considered as 
matches. These three strings will also match strings like "E P", "Elvis Aron Presley" and "E A P". Please 
refer to the Find Duplicates Tracks dialog for more details. 
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Edit Title/Artist 

Located on 
menu: 

Tools 

Shortcut key: None 

Enabled when: One or more tracks are loaded in the Project window and the current project can be 
modified 

Dialog 
displayed: 

Edit Track 

Toolbar 
button: 

 

 

This command opens the Edit Track dialog, allowing you to modify Disc name, Track number, Title, Artist 
and Genre for the selected track(s). If multiple tracks are selected the dialog presents options to select 
which fields are updated when the OK button is clicked. If a single track is selected the dialog presents 
an option to use the configured disc lookup catalog for selecting track information. 

Please refer to the Edit Track dialog for more details. 

 

 

 

Load Title/Artist 

Located on 
menu: 

Tools 

Shortcut key: None 

Enabled when: One or more tracks are loaded in the Project window and the current project can be 
modified 

Dialog 
displayed: 

Load Track Information or Load Disc Tracks Info depending on project type 

Toolbar 
button: 

 

 

Opens a dialog that can be utilized to fill the project list with title, artist name, disc name, track number 
and/or genre for all/selected tracks. There are various ways of retrieving this information for each track, 
depending on the project type and how track files are named. 

Please refer to the respective dialog for more details. 

 

 

 

Format Title/Artist 

Located on 
menu: 

Tools 
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Shortcut key: None 

Enabled when: One or more tracks are loaded in the Project window and the current project can be 
modified 

Dialog 
displayed: 

Format Title And Artist 

Toolbar 
button: 

None 

 

Displays the Format Title And Artist dialog to help you format title and/or artist names for all/selected 
tracks in the project list. Formatting can be done with respect to capitalization, location of THE and A, 
and order of name parts. Please refer to the dialog documentation for more details. 

 

 

 

Submit to freedb 

Located on 
menu: 

Tools 

Shortcut key: None 

Enabled when: The current project is loaded from a Karaoke (or audio) CD 

Dialog 

displayed: 

Submit CD+G Disc To freedb 

Toolbar 
button: 

None 

 

Opens the dialog that allows you to submit the current CD track list to freedb. Please consult the dialog 
documentation for more details. 

By using freedb as the CDG disc track information repository you will contribute to one of the worlds 
largest free CD database. CDGFix 3 Super, by default, consults freedb when a CDG disc is loaded into the 
Project window, thus enabling you to benefit from a common resource built by the community. 

 

 

 

Rename Track Files 

Located on 
menu: 

Tools 

Shortcut key: None 

Enabled when: One or more tracks are loaded in the Project window and the current project is file 
based and can be modified 

Dialog 
displayed: 

Rename Project Track Files 

Toolbar 
button: 

 

 

Using the Rename Project Track Files dialog displayed by this command, you can rename all/selected 
track files currently loaded into the project. New track file names can be constructed from one or more of 
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the project list columns Title, Artist, Disc, Track and Genre. Please refer to the dialog documentation for 

more details. 

 

 

 

Scan Tracks 

This menu item is new in CDGFix 3 Super version 3.4b 
 

 

Located on 
menu: 

Tools 

Shortcut key: None 

Enabled when: One or more tracks are loaded in the Project window (not from a Karaoke CDG), 
and the player is paused / stopped 

Dialog 
displayed: 

Scan CD+G File 

Toolbar 
button: 

None 

 

Scans all - or selected - tracks in the current project to detect errors, and possibly fix them. A fast and 
convenient method of finding errors, as well as fixing common errors that have a single solution. Please 
refer to the Scan CD+G File dialog more information on how to utilize this function. 

 

 

 

Load ID3 Tags 

Located on 
menu: 

Tools 

Shortcut key: None 

Enabled when: One or more tracks are loaded in the Project window and the current project is file 
based 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

This command enables you to (re)load ID3 tags for all/selected tracks in the project list. This can be 
useful, for example, if you have changed the track information in the project and want to revert to the 
information stored in each track's corresponding MP3 file. 

When invoking this command you will first be prompted whether to load ID3 tags for all, or selected 
tracks only: 
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Next, CDGFix 3 Super will ask how to treat tracks that lacks ID3 tags: 

 

By answering Yes to this question CDGFix 3 Super will clear the project columns Title, Artist, Disc, Track 
and Genre for any track that doesn't have ID3 tags in the corresponding MP3 file. Answer No to leave the 
columns as they are for these tracks. 

After the final question is answered, unless you selected Cancel, CDGFix 3 Super will start loading ID3 
tags and update the project list accordingly. 

 

 

 

Write ID3 Tags 

Located on 
menu: 

Tools 

Shortcut key: None 

Enabled when: One or more tracks are loaded in the Project window and the current project is file 

based 

Dialog 
displayed: 

None 

Toolbar 
button: 

None 

 

This command enables you to update or remove ID3 tags for all/selected tracks in the project list. ID3 
tags are stored in each track's corresponding MP3 file. 

When invoking this command you will first be prompted whether to write ID3 tags for all, or selected 

tracks only: 
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Next, CDGFix 3 Super will ask how to treat tracks where the project columns Title, Artist, Disc, Track and 
Genre are empty: 

 

By answering Yes to this question CDGFix 3 Super will remove any existing ID3 tags for each track where 
the above mentioned project columns are empty. If you want to remove ID3 tags for a set of tracks you 
can then select the relevant tracks and clear the information for these tracks by use of the Edit 
Title/Artist command before invoking Write ID3 Tags. 

Answer No to leave any existing ID3 tags as they are for tracks with empty Title, Artist, Disc, Track and 
Genre columns. 

After the final question is answered, unless you selected Cancel, CDGFix 3 Super will start writing ID3 
tags as instructed. 

 

 

 
Project toolbar 

 

 

The toolbar buttons are as follows: 

 Project Open. By clicking on the down arrow  a menu with the Most Recently Used files will 
be displayed. 

 Project Save. By clicking on the down arrow  a menu will display, containing the items 
Save, Save As and Save Tracklist As CSV. 

 Project Print. 

 Project Load Disc. By clicking on the down arrow a menu with the available CD/DVD drives 
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will display, allowing for quick load from the selected drive. 

 Project Eject Disc in Drive. 

 Edit Copy Tracklist as CSV. 

 Project Export Tracks. 

 Project Add File. 

 Project Add Folder. 

 Tools Edit Title/Artist. 

 Tools Load Title/Artist. 

 Tools Rename Track Files. 

 Tools Find Track. 

 Project Properties. 

 Tools Create Songbook. 

 

The textbox to the right on the toolbar is used to quickly search for a track in the list. The typed in words 
are matched to the title and artist columns, in any order. As an example, the search phrase "elvis jail" 
will match the track Jailhouse Rock by Elvis Presley. The search words can appear anywhere in one of the 
title and artist columns, and need not be spelled out completely. 

 

 

 
Project statusbar 

The project statusbar is located at the bottom of the Project window: 

 

 

The project statusbar has four panels as shown above. These panels are, from left to right, as follows: 

 Tracks; total number of tracks 

 Total size; the total size on disc of all tracks 

 Selected; number of selected tracks 

 Selection size; size on disc of the selected tracks 

 

Context menus 
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Context menus 

Context menus  - or, more correctly, context sensitive menus or popup menus - are available by clicking 
the right mouse button. Depending on where the mouse pointer is when right-clicking different menus 
will display, hence the term context sensitive. The items on the popup menu reflects the most common 
operations available for the location or item where the right-click occurred. Context menus hence makes 
it simpler to access frequently used commands because you can select an item and execute a command 
in the same (right-) click operation. Alternatively you would have to first select an item by left-clicking it 
and then point to the required menu or toolbar and click again to execute the command. 

CDGFix 3 Super provides context menus in the Player, Project, Instructions and Thumbnails windows. 
Please refer to each section for more details. 

 

Thumbnails 

 

 

Thumbnails 

 

The Thumbnails window context menu has some unique commands as well as some items that can be 

found other menus. The items on this context menu all operate on the currently loaded track. Please 
refer to each item below for more details. 
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Jump To Beginning 

This command positions the player on the first instruction of the selected thumbnail. Along with the Jump 
To End command this makes it simple to visually navigate to main locations in the track. 

 

 

 

Jump To End 

This command positions the player on the first instruction after the selected thumbnail. The same 

operation is available simply by pointing to the thumbnail with the  cursor and clicking. Along with the 
Jump To Beginning command this makes it simple to visually navigate to main locations in the track. 

 

 

 

Mark 

Places the Selection markers at the beginning and end of the selected thumbnail, providing a quick way 
for selecting an instruction block for use by other commands. 

 

 

 

Load Block 

Provides functionality similar to the Main menu File Load Block command. The difference lays in that the 
selected thumbnail is first marked for block operation before the Load Block operation is executed. 

 

 

 

Save Block 

Provides functionality similar to the Main menu File Save Block command. The difference lays in that the 
selected thumbnail is first marked for block operation before the Save Block operation is executed, 
providing a fast way of saving a specific instruction block to file. 

 

 

 

Print 

Prints the selected thumbnail. The picture is scaled to fit the selected paper size. 

 

 

 

Print All 
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Prints all the thumbnails. The pictures are scaled to fit eight thumbnails on each printed page. 

 

 

 

Export 

Saves the selected thumbnail to a graphics file in BMP format. 

 

 

 

Refresh 

Rebuilds the list of thumbnails to reflect any changes made to the track since the last thumbnail 
generation. 

 

 

 

Options 

Displays the Thumbnails page in the Settings dialog. On this page you may select how to detect 
thumbnail boundaries. 

 

 

 
Instructions 
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The context menu in the Instructions window is identical to the Main Play menu. Please refer to this 
menu for details. 

 

 

 
Player 

 

 

The Player window context menu is identical to the Size submenu on the Main View menu. Please refer to 
this menu for details. 

 

 

 
Project 
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The Project window context menu contains the most commonly used items from the various project 
menus. Please refer to each item for more details: 

 Add File 

 Add Folder 

 Remove Track 

 Clear 

 Load Track 

 Track Info 

 Find Track 

 Edit Title/Artist 

 Load Title/Artist 

 Format Title/Artist 

 Load ID3 Tags 

 Write ID3 Tags 

 Select All 

 Select None 

 Invert Selection 

 

Dialogs 

 

 
Dialogs 
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Many of the menu items and toolbar buttons opens a dialog to collect information for the task about to 

be carried out. A dialog is a window that allows you to enter textual information and/or select options 
from lists to instruct CDGFix 3 Super how to execute the task in question. 

This chapter gives an overview of all the CDGFix 3 Super dialogs, along with detailed explanations on 
how to use each one of them to achieve what you want. 

 

The following applies to CDGFix 3 Super version 3.4 and newer only 
 

 

To access the relevant topic directly from a dialog you can either hit the F1 key on your keyboard or click 
the question mark in the dialog title bar (see below). 

Most CDGFix 3 Super dialogs have a question mark button in the top right corner. Click 

this button to get directly to the help topic that describes the dialog in question. 

 

 

 
About CDGFix Super 

The About CDGFix Super dialog displays information about the installed CDGFix 3 Super version: 

 

Clicking the Visit The CDGFix homepage directs a browser window to the CDGFix homepage, while 

clicking the System Info button opens the Microsoft System Information tool. 

A click on the dimmed background text (CDGFix Crew) makes the CDGFix Crew team member names 
move around. 

 

 

 
Border Preset 

The Border Preset dialog is one of the six CDG instruction editing dialogs. The other five dialogs are: 

Memory Preset 

Tile Block Normal and Tile Block XOR 

Scroll Copy and Scroll Preset 

Define Color Transparency 

Load Color Table 
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The Border Preset dialog has the following layout: 

 

The Color selector is used to select which color index is used to preset the border cells of the graphics 
canvas. 

For more information about this and other CDG instructions and their usage please refer to The CDG 
graphics format. 

 

 
Browse Available Disc Catalogs 

 

 

 

 
Browse For Folder 

This dialog is displayed whenever CDGFix 3 Super needs to browse for a folder name: 

 

 

This dialog has a slightly different appearance in different Windows versions, but the basic functionality is 
the same. You use the tree view to navigate the drive and folder structure and select the folder to use for 
the current operation. The Make New Folder button can be used to create a new folder in the currently 
selected branch of the structure. 
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Change Channel 

The Change Channel dialog - accessed by the Change Channel command on the Tools main menu - is 
used to move Tile Block Normal and/or Tile Block XOR instructions from one channel to another. The 
operation can be applied to the entire loaded track, or limited to the current Selection, if any. 

 

Select the source and target channels in the From Channel and To Channel drop down lists. In the 
Instructions list you select one or both of the two Tile Block instructions to affect. Finally, under Change 
channel in you select which on part of the loaded track to apply the operation. If there are no current 
selection the Selection option will be disabled - if available and selected the change channel operation 
will only affect the selected Tile Block instructions between the selection start and end markers. 

For an introduction to the channels concept please refer to The CDG graphics format. 

 

 
Change Color Index 

 

 

 
Change Color RGB 

 

 

 
Create New SuperCDG Library 
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Create Songbook From Project 

The Create Songbook dialog - available by selecting Create Songbook from the Tools project menu - lets 
you create a songbook b ased on the currently loaded project. 

 

 

 

 

 
Define Color Transparency 

The Define Color Transparency dialog is one of the six CDG instruction editing dialogs. The other five 
dialogs are: 

Memory Preset 

Border Preset 

Tile Block Normal and Tile Block XOR 

Scroll Copy and Scroll Preset 

Load Color Table 

 

The Define Color Transparency dialog has the following layout: 
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The dialog displays the currently defined 16 color table entries, and a transparency value for each color 

entry. The transparency value can be set to a value in the range 0-63 for each color. 

The CDG standard defined by the Red Book states that each color entry can have a separate 
transparency level defining how much of the underlying background that is visible. The CDG graphics 
engine used by CDGFix 3 Super however has a limitation forcing transparency to be applied to a single 
color entry only, and only as completely opaque or completely transparent. For more details about this 
limitation and the effects it may have please refer to The CDG graphics format. Here you will also find 
more information about this and other CDG instructions and their usage. 

 

 
Delete Project 

 

 

 
Edit Track 

 

 

 
Error Message 

 

 

 

 
Export Tracks 

The Export Tracks dialog, available from the Export Tracks item on the Project menu, is one of the 
central working horses of CDGFix 3 Super. using this dialog you can convert tracks between the different 
supported formats, extract tracks from SuperCDG and Neo+G libraries, and build various CAVS menu 

files (English.inx, list.txt, etc.). You can even use this dialog to automatically organize your tracks in 
different folders for each artist or disc. 

The export works on the tracks currently loaded in the Project window, independent on the format of the 
original tracks. Different formats can be intermixed in the project, and all will be converted to the target 
format selected. The original tracks are not modified. 

If the appropriate columns in the project are populated CDGFix 3 Super will use this information to ID3 
tag the resulting MP3 files. The information used for ID3 tagging are disc name, track number, artist 
name, track title and genre. ID3 tagging can be controlled through the ID3 Tagging page of the Settings 
dialog. Tagging MP3 files of course depends on the selected target format; if the selected target format 
does not make use of MP3 files no tagging is performed. 
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The Export Tracks dialog looks like this: 

 

The Channel mixing (MPX) option is available with CDGFix 3 Super version 3.5a and 

newer only 
 

 

The dialog has four distinct parts, each dealing with one specific set of options. Each part is described in 
the following. 

 

Destination folder and existing files 

At the top of the dialog is the Destination folder option. This is the root folder where the resulting files 
will be placed. Simply click the ellipses button on the right hand side of the textbox to select the folder, 
or type the folder name directly into the textbox. If the folder name you type in does not exist you will 
be prompted to confirm creation of it when the export is started. 

Next follow four options to decide how existing files - if any - should be handled: 

 Leave existing files - do not replace: If the export results in a file name that already exists in the 

destination folder CDGFix 3 Super will leave the existing file, discarding the new file. 

 Confirm before replacing existing files: If the export results in a file name that already exists in 

the destination folder CDGFix 3 Super will ask you whether to keep the old file or replace it with 
the new one. 
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 Replace any existing files: CDGFix 3 Super will replace any existing file with a new file with the 

same name. 

 Delete any existing files in the destination folder: All existing files in the destination folder will be 

deleted when the export is started. You will be asked to confirm the deletion. 

 

Target format 

The Target Format option lets you select the required format of the tracks that are exported. 

Note: You will not find SuperCDG and Neo+G in the target format list. If you want to build a SuperCDG 

or a Neo+G library you cannot use the Export Tracks dialog. You must then use the Save As item on the 
Project menu instead. 

 

Channel mixing (MPX) allows you to remove or copy the left or right stereo channel during the export. 
The main goal of this is to remove vocals on multiplexed tracks. The default selection is Left and right 
channels as original, meaning that the sound will not be altered in any way. The other options are as 
follows: 

 Replace left channel with right channel: The original left channel sound will be removed and the 

right channel will be duplicated onto the left channel. Use this option to remove vocals 
multiplexed on the left channel. 

 Replace right channel with left channel: The original right channel sound will be removed and the 

left channel will be duplicated onto the right channel. Use this option to remove vocals 
multiplexed on the right channel. 

 Replace left channel with silence: The left channel sound will be removed completely, leaving 

sound only on the right channel. 

 Replace right channel with silence: The right channel sound will be removed completely, leaving 

sound only on the left channel. 

 

File names and index files 

The exported tracks can be given file names in three different ways, depending on the information 

available in the project and what you need. The different options are: 

Use the original filename 

This option copies the original file name for each exported track, assigning it directly to the new tracks. If 
the original file names are as you want them and you only need to change the format of the tracks then 
this is the option to use. 

Assemble target filename from mask 

Using this option for file naming you can assemble the file names of the exported tracks from various 
columns in the project. This requires that the columns you are going to use are populated with the 
relevant information. If one or more of the columns are empty you populate them before exporting using 
the Load Track Information dialog. 

When using this option you must enter a file name mask in the Filename mask field to assemble the 

information, or select a predefined mask from the drop down list. The drop down list also remembers 
recently used masks. The mask is made up of project column designators, separator characters and 
possibly text literals. The available project column designators are: 

 I: Will be replaced by the project track index in the leftmost # column. 

 D: Will be replaced by the disc name in the Disc column. 

 #: Will be replaced by the track number in the Track column. 

 T: Will be replaced by the track title in the Title column. 

 A: Will be replaced by the artist name in the Artist column. 

 G: Will be replaced by the track genre in the Genre column. 
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Normally you will insert separators in the mask, separating the various parts from each other. Usual 

separators are the characters - and _, but any character can be used (using one of the column 
designators as separator requires using a text literal - see below). You can also combine multiple 
characters into a single separator simply by typing them in together like -_-. Correct use of separators 
are essential if you at some later time need to automatically split the file names into their separate parts 
again using the Load Track Information dialog. 

A text literal in the mask is simply a piece of constant text that is inserted directly into the resulting file 
name. Any character that is not recognized as a column designator is treated as a text literal. However, if 
you want to insert one of the reserved column designator characters you must enclose the text literal in 
double quotes "". 

If you want to organize the exported tracks in sub-folders of the selected destination folder you can 
embed the path separator \ in the file name mask. CDGFix 3 Super will detect and create sub-folders in 
the resulting file name. For example, by using \ as a separator between the A and T fields, like A\T, you 

will get one folder for each artist, containing all tracks for that artist and having the title as file name. 

Some examples - all assuming that the track columns are disc = SC012, track number = 05, artist = 
Elvis Presley, title = Jailhouse Rock, and genre = Rock: 

File name mask Resulting file name (and possibly path) 

D - # - A - T SC012 - 05 - Elvis Presley - Jailhouse Rock 

D\#_A_T SC012\05_Elvis Presley_Jailhouse Rock 

G\A\T Rock\Elvis Presley\Jailhouse Rock 

"Artist="A" - 
Title="T 

Artist=Elvis Presley - Title=Jailhouse Rock 

 

Finally, the Replace illegal filename characters with option designates a character with which CDGFix 3 
Super will replace any character in the resulting file name that is not allowed. Under the Microsoft 
Windows operating systems the following characters are not allowed in file names: \ / : * ? " < > | 

Sequential numbering 

The final file naming option is Sequential numbering. This will give each resulting track a sequentially 
increased number, as well as offer the option of creating an index file of the exported tracks. Using this 
file naming scheme requires the entry of a start number, number of digits to use, and optionally the 
selection of an index file format. 

By default the starting number is set to one, but you may change this to any number that suits your 
needs. If you for example already have exported and numbered 1250 tracks it would make sense to 
change the starting number to 1251. 

The number of digits option determines the minimum number of digits to use in the file names. If the 
actual number for a given file requires fewer digits that specified the file name will be left-padded with 
zeros. If more digits are required than specified the file name will be expanded to accommodate all 
digits. 

The selection of an index file offers the following choices: 

 No index file: No index file will be created. Using this option ID3 tagging will be the only means 

of knowing the artist name and title of each exported track. If the selected target format does 
not include an MP3 file, for instance the BIN format, you will not be able to identify the tracks. 

 CSV file: This creates a comma separated file with the columns index, title and artist. 

 CAVS ENGLISH.inx menu file: This option will build a CAVS ENGLISH.inx menu file of the 

exported tracks, for use with various CAVS players (for instance the 203G players). 

 list.txt file: This option builds a text file with the columns index, title and artist, separated by 

vertical bar |. Various CAVS players can utilize this file. 

 CAVS ENGLISH.inx menu file + juke.txt: This option results in both a CAVS ENGLISH.inx menu 

file and a juke.txt file containing the columns index, title and artist, separated by hash sign #. 

All index files are written to the selected destination folder. 

The list.txt index file is the only index file type that offers an append option. The other index file types 
will result in overwriting of an existing index file of the same type after confirmation. However, if an 
existing list.txt index file is found you will be given the option of overwriting or appending. If you select 
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append CDGFix 3 Super will scan the existing file to determine the next sequential file name number. 

This number will override the one specified. 

 

Which tracks to export 

Finally you can select which tracks to export; all tracks in the project or only the highlighted tracks. A 

single track is selected by left-clicking on it, while multiple tracks can be selected by holding the Shift 
and/or Ctrl buttons down while left-clicking. Selecting single or multiple tracks follows standard Windows 
selection principles. 

 

When all options have been set to your requirements simply click the Run button to start the export 
process. You will see a progress dialog informing you of the work, along with a Cancel button should you 
want to abort the process. After the export has completed CDGFix 3 Super will present a summary of the 
work done. (Display of the summary is controlled on the General page in the Settings dialog. 

 

 
Find Duplicate Tracks 

 

 

 
Find Track 

 

 

 
Format Title And Artist 

 

 

 
freedb Select Server 
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freedb Server Map 

 

 

 
HEX Editor 

 

 

 
Insert Packets 

 

 

 
Jump To Position 

 

 

 

 
License Key 

The License Key dialog is used to register your license key and user information. 
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At the top you will see the product key for you specific installation of CDGFix 3 Super. Below are six 
textboxes for entering the license key you have received - one box for each group of four characters. To 
ensure the license key are entered correctly we suggest that you use copy and paste. Highlight the 
license key in the registration email you received and select copy. Then click in the leftmost textbox to 
activate it, and select paste (ctrl+v). The license key should now appear with each part in its own 
textbox. Finally enter your name and email address at is appears in the registration email, and click OK. 
Your full version of CDGFix 3 Super is now ready for use. 

 

 

 
Load Color Table 

The Load Color Table dialog is one of the six CDG instruction editing dialogs. The other five dialogs are: 

Memory Preset 

Border Preset 

Tile Block Normal and Tile Block XOR 

Scroll Copy and Scroll Preset 

Define Color Transparency 

 

The Load Color Table dialog has the following layout: 

 

Load Color Table Low - index 0 to 7 
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Load Color Table High - index 8 to 15 

Depending on the Load Color Table instruction selected the dialog will display as one of the above two 
versions. Their functionality and usage are identical. 

Clicking on a color index cell brings up the Windows standard color selection dialog (please ntoe that this 
dialog may appear different in different Windows version, but the basic functionality is identical): 

 

When a new color is selected and the color selection dialog is closed with the OK button the color index 
cell will be updated to reflect the change. Selecting OK in the Load Color Table dialog will then update the 
instruction. 

For more information about this and other CDG instructions and their usage please refer to The CDG 
graphics format. 

 

 
Load Disc Tracks Info 
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Load Track Information 

The Load Track Information dialog, available from the Load Title/Artist menu item on the project Tools 
menu, is the mail tool for loading information from various Disc Catalogs into the Project window. If the 
tracks you have loaded are missing information like title and artist, or some of it is incorrect, you can use 
this dialog to load the correct information. 

The dialog looks like this: 

 

Please note that the available options vary slightly depending on the type of project currently loaded. 
The dialog as shown above is valid for a native CDGFix 3 Super project (file type CFP). 

The Wizard button at the lower left of the dialog invokes the Load Track Information Wizard to guide you 
through the options. 

The dialog has several groups of options. Each group is described in the following. 

 

Source of track information 

The option "Extract track information fom the filename manually" is available in CDGFix 

3 Super version 3.6h and newer only 
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At the top of the dialog are three options allowing you to select the source of the track information. The 
options are: 

 Extract track information from the filename using mask: This is the simplest way of loading 
information for each track, if the file names contain the information in a readable format. Often 

tracks are named like SC022-05-Elvis Presley-Jailhous Rock. Selecting a proper file name mask 
lets you extract this information - refer to File name mask below for details. 

 Extract track information from the filename manually: Like the above option this option will 
extract information from the file names. However, if the files are named in such a way that using 

a mask is not possible, this option will let you pick the information manually for each track by 
pointing at the different file name parts. This is accomplished by launching the Manually Extract 
Track Information for each track. 

 Lookup track information by disc and track #: If the file names are incomplete regarding track 

information, or if you want to correct some of it, you are required to use a Disc Lookup Catalog. 
Selecting this option you can use disc name and track number to load titles and artist names. 
You must select how to get disc name and track number, and how to lookup them up i a Disc 
Catalog. Please refer to Looking up in a disc catalog below for details. 

 Lookup track information by title and artist: This option is similar to the previous option, except 

in that title and artist name are used for lookup in a Disc Catalog instead of disc name and track 
number. This is convenient when disc names and/or track numbers are missing and you want to 
refresh or verify titles and artist names. Refer to Looking up in a disc catalog below for 
further information. 

  

Looking up in a disc catalog 

CDGFix 3 Super can use various songbook programs - known as Disc Lookup Catalogs - as the source for 
track information. When you select one of the two Lookup track information... options additional options 
will be enabled to allow you to specify how to do the lookup. Please note that you must have at least one 
disc lookup catalog configured with CDGFix 3 Super to use this option - see the Disc Catalogs page of the 
Settings dialog for more details. 

First you have to select from where to get the source information for lookup: 

 Extract disc and track # (or title and artist) from the filename using mask: This option requires 
that disc names and track numbers or titles and artist names, respectively, are part of the file 
names and can be extracted using a proper mask. Please see File name mask below for details. 

 Get disc and track # (or title and artist) from the corresponding fields in project: If the disc 

name and track number or title and artist name columns, respectively, in the project are already 
populated this information can be used directly for lookup. 

Second, CDGFix 3 Super needs to know how to match the lookup information: 

 Find disc (or title and artist) in catalog by exact match: If this option is selected CDGFix 3 Super 
will only find entries in the disc lookup catalog that exactly matches the search criteria 
(uppercase/lowercase is insignificant). This is the fastest search method, but will not always find 
the searched information, depending on how it is formatted in the source (i.e. the file name). 

 Find disc (or title and artist) in catalog by smart search: This search form is somewhat more 
expensive that exact matching, but allows CDGFix 3 Super to find matches that are not spelled 
exactly as expected by the disc lookup catalog. Smart search considers disc names like SC022, 

SC22 and SC-22 to match. The following artist names are also considered to match using smart 
search; Elvis Presley, Presley Elvis, Elvis Aron Presley. 

Finally you must select the disc lookup catalog to use. The drop down list Select Catalog lists the 
configured and available catalogs. 

 

File name mask 

Some of the above options require the selection of a file name mask in order to extract information from 
each track's file name. Please note that the available mask characters depend on the previously selected 
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options (for instance, the A and T mask characters have no meaning when performing disc catalog 

lookup based on disc name and track number. 

The file name mask is assembled from the available mask characters and one or more separator 
characters. The separators must match the separators actually used in the file names. Different 
separators may be used between the various parts of the mask. 

The available mask characters are as follows: 

 D: Matches the position of the disc name. If the disc name consists of multiple parts divided by 

the same separator character as the rest of the file name simply add as many Ds as required. 
See examples below. 

 #: Matches the position if the track number in the file name. 

 T: Matches the position of the track title in the file name. 

 A: Matches the position of the artist name in the file name. 

 G: Matches the position of the genre in the file name. Note that genre is not used for lookup via 

disc catalogs, hence this mask character is only available when populating the project fields 
directly from the track file names. 

Some file name mask examples: 

File name You want to extract File name mask to use 

SC022-05-Elvis Presley-
Jailhouse Rock.cdg 

Disc name and 
track number 

D-#- 

SC022-05-Elvis Presley-
Jailhouse Rock.cdg 

Title and artist --A-T. 

SC022-05-Elvis Presley-

Jailhouse Rock.cdg 

All fields D-#-A-T. 

PHM22-04-12-The Zoo-
Scorpions 

Disc name and 
track number 

DD-#- 

 

 

Select which tracks to update 

You can select to update all or highlighted tracks only, or only tracks having one or more fields empty. 

 Update all tracks in the project: All tracks in the project will be updated, replacing any 
information already present. 

 Only update tracks where...: Selecting this option enables you to select one or more project 

fields that need to be empty for a given track to be updated. If the project for example contains 
many tracks, but only a few are missing titles and artist names, this option can be used to 
update those tracks only. 

 Update selected tracks only: Updates only the highlighted tracks. A single track is selected by 
left-clicking on it, while multiple tracks can be selected by holding the Shift and/or Ctrl buttons 
down while left-clicking. Selecting single or multiple tracks follows standard Windows selection 
principles. 

 

What to when no information is found 

Selecting the Clear track information when no match is found option makes CDGFix 3 Super clear all 

fields for tracks where no match in the disc lookup catalog is found. This can be useful if you want a 
visual indication on which tracks couldn't be matched. 

 

Confirm updates 
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Finally you have the option to be asked for confirmation before each track is updated with new 

information. In some cases it is useful to have full control over the process and be able to decide which 
tracks to update. Optionally you can choose to be asked for confirmation only if multiple matches are 
found for a given track, in which case you can select which match to use. Multiple matches for a single 
track are normally only encountered when looking up in a catalog based on title and artist name. 

 

When all options have been set to your requirements simply click the Run button to start the job. You 
will see a progress dialog informing you of the work, along with a Cancel button should you want to abort 
the process. 

 

 
Load Track Information Wizard 

 

 

 

 
Memory Preset 

The Memory Preset dialog is one of the six CDG instruction editing dialogs. The other five dialogs are: 

Border Preset 

Tile Block Normal and Tile Block XOR 

Scroll Copy and Scroll Preset 

Define Color Transparency 

Load Color Table 

 

The Memory Preset dialog has the following layout: 

 

The Color selector is used to select the color index with which to clear the graphics canvas, and the 
Repeat value identifies the sequence of this Memory Preset instruction. 

For more information about this and other CDG instructions and their usage please refer to The CDG 
graphics format. 

 

 
Open File 
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Print 

 

 

 
Properties For Project 

 

 

 
Properties For Track 

 

 

 
Recover Instruction 

 

 

 
Rename Project Track Files 

 

 

 
Save File As 
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Save Track To SCDG File 

 

 

 
Scan CD+G File 

 

 

 

 
Scroll Copy and Scroll Preset 

The Scroll Copy/Preset dialog is one of the six CDG instruction editing dialogs. The other five dialogs are: 

Memory Preset 

Border Preset 

Tile Block Normal and Tile Block XOR 

Define Color Transparency 

Load Color Table 

 

The Scroll Copy dialog has the following layout: 

 

The Scroll Preset dialog looks like this: 
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The only difference between the two dialogs is the presence of the Preset color selector, used to select 
the color that is used to fill the newly revealed column or row. 

For each scroll direction - horizontal and vertical - you select the desired Scroll mode and Pixel offset. 

For more information about this and other CDG instructions and their usage please refer to The CDG 
graphics format. 

 

 
Select CD/DVD Drive 

 

 

 
Select Channel 

 

 

 
Select Channels 

 

 

 
Select Colortable 
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Select Disc 

 

 

 
Select Instruction 

 

 

 
Select SCDG Track 

 

 

 
Select Track Title And Artist 

 

 

 
Select Workspace Name 
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Settings 

 

Settings 

The Settings dialog is the heart of CDGFix 3 Super when it comes to configure how the program works. 
The Settings dialog is reached by selecting Settings on the Options menu. 

Due to the numerous configuration options the dialog is divided into several pages, each page containing 
related options. Each page is available through the tree view on the left hand side of the dialog: 

 

 

When an option is changed on one of the pages the Apply button becomes enabled. By clicking the Apply 
button the changes is saved permanently and the Settings dialog stays open. Clicking the OK button will 
close the dialog after the changed options have been saved. If you want to abandon your changes then 
click the Cancel button instead of Apply or OK. 

 

 

 

General 
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The General page of the Settings dialog contains the following options: 

 Auto play of track on load: When this option is selected CDGFix 3 Super will automatically start 
playing a track when it is loaded into the player/editor. The track can be loaded by the Open 
command on the File menu, or loaded from the project (Load Track). 

 Auto load of next track in project: Selecting this option makes CDGFix 3 Super automatically 

load the next track from the project when the currently playing track has finished. When both 
this option and Auto play of track on load is selected the project will act as a playlist, 
automatically playing the project tracks one by one. 

 Auto fullscreen on play: When this option is selected CDGFix 3 Super will automatically switch 
the Player window to Full Screen mode when a track starts playing. When the track has finished 
playing - or is stopped - the player automatically changes back to normal size. 

 Clear undo-stack on save: CDGFix 3 Super maintains a stack of all changes done to the track 

currently loaded into the editor, allowing you to undo/redo any changes (please refer to the 
Undo and Redo commands on the Tools menu for details). When the Clear undo-stack on save-
option is selected the undo-stack will be emptied when the track is saved, conserving memory. 

The implication of this is that noe changes can be automatically undone after the track has been 
saved. 

 

CDGFix 3 Super version 3.6 intriduces two new options on the General page: 
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 Ignore errors in batch jobs: Selecting this option forces CDGFix 3 Super to always ignore non-

fatal errors during batch jobs (f.ex. Export Tracks), instead of asking the Abort/Retry/Ignore 
question. 

 Display batch job summary: When this option is selected CDGFix 3 Super will present a job 

summary at the end of batch jobs informing you of what was done, and possibly any errors that 
was ignored. 

 

CDGFix 3 Super version 3.7 intriduces one new option on the General page: 
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 Use relative paths in CUE files: Use this option to select whether you want absolute or relative 

file paths in CUE files created using the Export Tracks dialog. Using relative paths makes it 
possible to move the CUE file and the corresponding BIN files to a new location after generation. 

 

Background 

 

 

Background 
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By default CDGFix 3 Super plays a track with the background color as defined by the track graphics. 

However it is possible use pictures as a static (Single Picture) or dynamic (Slide Show) background. To 
achieve this you must first decide how the transparent color is defined (the transparent color defines 
which parts of the graphics that will be replaced by the selected background picture). 

The transparent color can be defined as one of the following options: 

 The color set by the Define Transparency Color Command: Some CDG brands include the Define 

Color Transparency command to define which parts of the graphics that may be replaced by a 
background picture. Selecting this option makes CDGFix 3 Super adhere to the instructions given 
by the manufacturer to apply background pictures. Please note that the current implementation 
has some limitations with respect to the "Red Book" and color transparency - refer to The CDG 
graphics format for more details on this. 

 The color set by the Memory Preset command: Even though the Define Color Transparency 

command is not used by all brands, CDGFix 3 Super can provide some intelligence in deciding 
which color to make transparent. Almost all manufacturers use the Memory Preset command to 
paint the background, and hence it makes sense to use this color for transparency. 

 The color at index: You may select a specific color index for transparency, but be aware that you 

may have to change the color index when playing songs of different brands to get the desired 
result. When this option has been selected you can pick the color index from the drop down list. 

 The fixed RGB color: Makes all occurrences of a given RGB (Red-Green-Blue) color transparent, 

regardless of the color index. This may give unpredictable results since different color indexes 
may have the same RGB values but still be treated differently with respect to transparency. 
When this option has been selected you can click on the color box to bring up the color selection 
dialog. 

 No transparent background: The default, no transparency. As a result no background picture will 

be visible even if defined so on the Single Picture and Slide Show pages. 

 

 

 

Single Picture 
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On this page you can select to use a single picture as background for the lyrics. Activate the background 

picture by selecting the Use a single picture as background option. Next decide whether to use a specific 
picture (Use this picture option), or if you want CDGFix 3 Super to randomly select a new picture from a 
given folder each time a new track is played (Use a random picture from this folder option). Then click 
the Browse button to select the picture or folder. 

Finally you may select how to display the picture: 

 Center picture in background area: The picture is not scaled. If it is smaller than the graphics 

area the picture will be centered with borders in the current graphics background color. If the 
picture is larger than the graphics area only the center of the picture will be visible. 

 Stretch picture to fit background area: The picture will be scaled to exactly fit the graphics area. 

To avoid distortion you may also select Maintain picture aspect ratio, in which case the picture 
will have borders at top and bottom, or left and right, as appropriate. 

 Tile picture to fill background area: This will start by aligning the picture upper left corner with 

the graphics area upper left corner, and then tile the picture to the left and downwards until the 
entire graphics area is filled. 

Please note that in order to make the picture visible behind the graphics you must also select a 
transparent color on the Background page. 

Also pay attention to the fact that pictures of specific situations or happenings generally tend to draw 
attention from the lyrics, and hence may disturb the singer. Try to choose pictures that are neutral, like 
pictures of the sky or a mountain, or just a non-figurative pattern. A good choice of background may 
give more life to the lyrics than the default single color background, and still let the singer focus on the 
lyrics. 

 

 

 

Slide Show 
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On this page you can select to display a slide show as background for the lyrics. Activate the background 

picture by selecting the Run a slide show as background option. Then click the Browse button to select 
the folder where the pictures are stored. 

The display order of the pictures can be either by filename (Order pictures by filename option) or random 
(Display pictures in random order option). The first is useful if the pictures depend on a specific sequence 
to tell a story, while the latter gives a touch of surprise since the sequence of the pictures will constantly 
change. For the random option CDGFix 3 Super ensures that all pictures have been displayed before 
starting over again with a new sequence. 

The Transition option lets you choose how each picture will replace the previous one. The default 
transition, None, just display the new picture over the previous. The Dias transition first drags the old 
picture out sideways and then pushes the new one in, just like and old fashioned slide show machine. 
The rest of the transition options slides the pictures in and out in different directions, and in front or back 
of each other. Finally there is a Random Transition option that randomly select a transition type each 

time a picture will change. 

Picture display time specifies in seconds how long each picture will display before the next one. 

Transition time specifies in seconds how long each transition will take. 

Finally you may select how to display the picture: 

 Center picture in background area: The picture is not scaled. If it is smaller than the graphics 

area the picture will be centered with borders in the current graphics background color. If the 
picture is larger than the graphics area only the center of the picture will be visible. 

 Stretch picture to fit background area: The picture will be scaled to exactly fit the graphics area. 

To avoid distortion you may also select Maintain picture aspect ratio, in which case the picture 
will have borders at top and bottom, or left and right, as appropriate. 

Please note that in order to make the slide show visible behind the graphics you must also select a 
transparent color on the Background page. 

Also pay attention to the fact that pictures of specific situations or happenings generally tend to draw 
attention from the lyrics, and hence may disturb the singer. Try to choose pictures that are neutral, like 
pictures of the sky or a mountain, or just a non-figurative pattern. A good choice of background may 
give more life to the lyrics than the default single color background, and still let the singer focus on the 
lyrics. 
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Thumbnails 

 

 

The Thumbnails window uses these options to determine how to split the graphics into thumbnails: 

 Memory Preset commands: When selected this option will generate a new thumbnail each time a 

Memory Preset command is reached. This command is used to clear the graphics and hence 
makes a good option for dividing thumbnails. The downside is that not all manufacturers utilize 
the Memory Preset command. 

 Timing Gaps of at least: When this option is selected CDGFix 3 Super will generate a new 

thumbnail for each graphics "silence" of at least the entered number of seconds. This method is 
less accurate but can give a reasonable thumbnails division with the default 3 seconds gap. 

For more details of the graphics instructions please refer to The CDG graphics format. 

 

E-mail 

 

 

Email 
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CDGFix 3 Super has built-in functions for sending email to our support department. This is used by the 
Support option on the Help menu, and by the automatic error reporting system. To be able to use the 
email functionality please select the appropriate configuration for your computer: 

 Use the default E-mail client: This option will use the MAPI interface in Windows to send email 

through the current default email program. When selected you can click on the Configure button 
to go to the Default Client page for configuration details. 

 Use a specific SMTP server: If your ISP provides you with a SMTP server for outgoing email you 

can select this option to use that SMTP server. When selected you can click on the Configure 
button to go to the SMTP Server page for configuration details. 

 Use MailTo: protocol: This is the final option, and requires no further configuration if selected. 

This option uses the mailto:... syntax found on web pages to send email, and lets Windows 
handle the details when sending email. 

The Always send a copy of messages option, when selected, makes CDGFix 3 Super send a copy of all 
email messages to yourself. The email address used for CC is the address that you supplied when 
registering CDGFix 3 Super. See the License Key dialog for details. 

 

 

 

Default Client 
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The default email client depends on the email program, if any, you have installed on your computer. If a 

user name and/or a password is required to access the email client you can enter it on this page. 
Alternatively you can select the Display E-mail client login dialog option to let the email client prompt you 
with a login dialog if required. 

To test the default email client click on the Test button. This will generate and send a test message to 
your current email address (this is the address that you supplied when registering CDGFix 3 Super - see 
the License Key dialog for details). 

 

 

 

SMTP Server 
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This page lets you configure and use a designated SMTP server for sending email. Start by entering the 

name of your SMTP server as specified by your ISP. The default port number for SMTP is 25, but can be 
changed if your ISP has selected another port. 

The next thing to do is select the appropriate authentication method. Please refer to your ISP 
documentation for details. After selecting authentication method please enter a valid POP3 server name, 
or a user name and password, as requested. 

To test the default email client click on the Test button. This will generate and send a test message to 
your current email address (this is the address that you supplied when registering CDGFix 3 Super - see 
the License Key dialog for details). 

 

MP3 Encoding 

 

 

MP3 Encoding 
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When ripping a CDG disc or converting a BIN-file to some other format, CDGFix 3 Super needs to convert 

wave-format sound to MP3. For this purpose you can choose between to MP3 encoders; Lame and Blade 
- Lame being the default. 

Another option is to keep the sound in wave-format, but this is rarely practical. One use would be when 
ripping songs from one or more CDG discs for later burning new discs. Using wave-format storage in 
situations like this saves you the time used to encode and decode the MP3 stream, as well as it removes 
any quality loss. However, for permanent storage on HDD the storage overhead required by the wave-
format does not outweigh the minor quality loss of modern MP3 encoders. 

Clicking the Configure button takes you directly to the configuration page for the selected encoder, Blade 
and Lame respectively. 

 

 

 

Blade 
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The Blade MP3 encoder configuration is quite simple since it only allows for selection of the bitrate. 

Higher bitrates results in smaller quality loss at the cost of larger MP3 files. Bitrates above 192 tend to 
give little or none recognizable quality gain though. 

By clicking on the Blade logo at the upper right you will see a dialog like this: 

 

This gives you a summary of the current Blade encoder in use by CDGFix 3 Super, as well as a link to the 
Blade homepage. 

You may freely download and install newer version of the Blade encoder for use with CDGFix 3 Super. 
Make sure the encoder you download is compiled for Microsoft Windows, name it BladeEnc.dll, and copy 

it to the CDGFix 3 Super installation folder (which is normally C:\Program Files\CDGFix Crew\CDGFix 3.X 
Super). 

 

 

 

Lame 
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Configuration of the Lame encoder gives you slightly more options than the Blade encoder, though 

basically it is about selecting the required quality of the resulting MP3 files. 

Technically, the Lame encoder can use both constant and variable bitrates. The option suggested by the 
Lame developers are to use variable bitrate and concentrate on the resulting quality. This is done by 
selecting Quality in the Target box at the top, and then choose the desired quality in the Quality box at 
bottom. With this setup the Lame encoder will choose the appropriate bitrate for every single piece of the 
wave stream, resulting in the smallest possible MP3 file for a given quality. For more details on this 
encoding option and how it works please refer to the Lame homepage. 

But when it comes to practical use with CDGFix 3 Super there are other considerations to make. Not all 
players support variable bitrate MP3 streams correctly. Microsoft Windows is one for instance. When 
playing MP3 files CDGFix 3 Super utilizes the Microsoft Windows MCI (Media Control Interface) command 
set. The MP3 codec installed and used by MCI does not correctly calculate the length of variable bitrate 
MP3 files. The result is that CDGFix 3 Super gets reported from MCI that a MP3 file is maybe 54:30 long 

(almost an hour) while the length of the song actually is only 3:50. The result would be that after playing 
the song CDGFix 3 Super will continue to "play" silence for more than 50 minutes. More information 
about variable bitrate encoding can be found here. 

Therefore, until a better MP3 codec becomes available for MCI we suggest that you use the Lame 
encoder with target set to Bitrate, select the Restrict encoder to constant bitrate option, and choose the 
fixed bitrate you require - for example 192. 

By clicking on the Lame logo at the upper right you will see a dialog like this: 
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This gives you a summary of the current Lame encoder in use by CDGFix 3 Super, as well as a link to the 
Lame homepage. 

You may freely download and install newer version of the Lame encoder for use with CDGFix 3 Super. 
Make sure the encoder you download is compiled for Microsoft Windows, name it lame_enc.dll, and copy 
it to the CDGFix 3 Super installation folder (which is normally C:\Program Files\CDGFix Crew\CDGFix 3.X 
Super). 

 

 

 

ID3 Tagging 

 

 

CDGFix 3 Super can utilize the power of ID3 tagging when handling MP3 files. ID3 tags are pieces of 
information embedded into the MP3 file, containing information on title, artist name, genre, etc. for the 
track. CDGFix 3 Super both reads and writes ID3 tags: 
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 Auto load ID3 tags when adding track to project: When selected this option tells CDGFix 3 Super 

to scan each MP3 file as tracks are added to the Project window. When relevant information is 
found in the MP3 file the corresponding project columns are populated. This also works for ZIP 
archives with embedded MP3 files. 

 Auto write ID3 tags in MP3 file when ripping: Selecting this option instructs CDGFix 3 Super to 

write ID3 tags into the resulting MP3 files when ripping a CDG disc. The ID3 tag information is 
collected from the various project columns (i.e. title, artist, disc, track no., and genre). This way 
your ripped tracks will always carry the correct information within, and you don't have to rely on 
the filenames for track information. 

 

CDGFix version 3.4d and newer has two new options on the ID3: 

     (also note that the two existing options has slightly changed texts) 

 

 

 

 

 Update ID3 tags in MP3 file when exporting tracks: This option, when selected, tells CDGFix 3 
Super to write - or update - ID3 tags in MP3 files when exporting tracks from sources other than 

CDG discs (i.e. SuperCDG libraries, etc.). The ID3 tag information is collected from the various 
project columns (i.e. title, artist, disc, track no., and genre). 

 Clear existing ID3 tags when missing new info: When the above option is selected, CDGFix 3 

Super by default does not write empty ID3 tags, thus keeping any existing ID3 tag information if 
no new data is available from the project various columns. However, by selecting this option 
CDGFix 3 Super is forced to write ID3 tags regardless of the available information. The result is 
that any existing ID3 tags are cleared if the corresponding project column is empty. 

 

Disc Catalogs 
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Disc Catalogs 

 

 

CDGFix 3 Super can use various songbook software (Disc Catalogs) to populate the various columns in 
the Project window with track information. In order to use a specific songbook program with CDGFix 3 
Super you must first have it installed on your computer with a valid license. It is also possible to 
configure and use more than one songbook program, in which case you will be prompted for which one 
to use for a specific task. 

The Disc Catalogs configuration page is common for all configured songbook programs, and instructs 
CDGFix 3 Super how to format the information. By deselecting all options on this page the information 

will be used as it is delivered from each songbook program. However, by selecting the options of your 
preference you can achieve a standard formatting independently of which songbook program you use. 

For song titles the following options apply: 

 Capitalize: All words will have the first letter as uppercase and the rest as lowercase letters. 

 Uppercase: All words will have all uppercase letters. 

 Lowercase: All words will have all lowercase letters. 

 Trailing A and The: All titles that start with the words A or THE will have the A or THE shifted to 

the end, separated by a comma (,). 

 Leading A and The: All titles that have a comma separated trailing A or THE will have the A or 

THE shifted to the front and the comma removed. 

For artist names the following options apply: 

 Capitalize: All words will have the first letter as uppercase and the rest as lowercase letters. 

 Uppercase: All words will have all uppercase letters. 

 Lowercase: All words will have all lowercase letters. 

 Trailing A and The: All artist names that start with the words A or THE will have the A or THE 

shifted to the end, separated by a comma (,). 

 Leading A and The: All artist names that have a comma separated trailing A or THE will have the 

A or THE shifted to the front and the comma removed. 
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 Firstname Lastname: All artist names containing a single comma (,) are assumed to be on the 

form Lastname, Firstname and are swapped to Firstname Lastname. This formatting option is 
NOT applied if the artist name contains the word AND or an ampersand (&). 

 Lastname, Firstname: This option is currently not implemented, due to difficulties in determining 

whether names like Village People are a persons name or the name of a group. 

 

 

 

Karaoke Song List Creator 

 

 

To use the songbook program Karaoke Song List Creator, start by selecting the Use Karaoke Song List 
Creator for disc lookup option. Then click the Browse button and select the folder where the songbook 
program is installed. 

The next time you use functions like Load Title/Artist and Browse Disc Catalogs you will have the option 
of using Karaoke Song List Creator as your source of information. 

 

 

 

KJ-Pro 
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To use the songbook program KJ-Pro, start by selecting the Use KJ-Pro for disc lookup option. Then click 

the Browse button and select the folder where the songbook program is installed. 

CDGFix 3 Super recognizes both version 1 and 2 of KJ-Pro. After having selected the songbook program 
installation folder you will be informed on the version found. 

The next time you use functions like Load Title/Artist and Browse Disc Catalogs you will have the option 
of using KJ-Pro as your source of information. 

 

 

 

Music Book Deluxe 
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To use the songbook program Music Book Deluxe, start by selecting the Use Music Book Deluxe for disc 

lookup option. Then click the Browse button and select the folder where the songbook program is 
installed. 

The next time you use functions like Load Title/Artist and Browse Disc Catalogs you will have the option 
of using Music Book Deluxe as your source of information. 

 

 

 

FastTracks SongBook Creator 
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To use the songbook program FastTracks SongBook Creator, start by selecting the Use FastTracks 

SongBook Creator for disc lookup option. Then click the Browse button and select the folder where the 
songbook program is installed. 

The next time you use functions like Load Title/Artist and Browse Disc Catalogs you will have the option 
of using FastTracks SongBook Creator as your source of information. 

 

 

 

CSV File 



Using CDGFix 3 Super 

145 

 

 

The CSV Disc Catalog support is a generic option that allows you to use CSV files generated by various 

means as source for track information. A CSV file is a text file with columns separated by a semicolon (;) 
or a TAB character. They can be created by a text editor, with a spreadsheet program, or exported from 
several other songbook programs. 

To use a CSV file for track information lookup you start by selecting the Use a CSV file for disc lookup 
option. Next click the Browse button and select the CSV file to use. 

The selected CSV file may or may not contain a header row. You indicate this by selecting or deselcting 
the The CSV file contains a header row option as appropriate. 

Finally CDGFix 3 Super needs to know which columns the CSV file contains and the order in which they 
appear. For each of the six supported columns enter the index of the column in the file, starting with 
index 1 for the leftmost column. If a column is not present in the CSV file you should enter 0 as the 
index. 

 

 

 

freedb Lookup 



CDGFix 3 Super help 

146 

 

 

freedb is a freely available source of information regarding discs. Traditionally freed is used for storage 

and lookup of standard audio CDs, but using CDGFix 3 Super the Karaoke community can now utilize this 
easy-to-use technology for CDG discs as well. 

The settings for the freedb server, protocol, port number and script path are best left with their default 
values. There is no need to change these values unless the communication parameters are changed by 
the freedb team, or you want to use another similar service. You may have to change the protocol 
though, depending on your ISP configuration. If the HTTP protocol doesn't work you may try using 
CDDBP, or vice versa. Note that when switching between the two protocols the configured port number 
will change automatically to the default value for the selected protocol. 

The freedb communication protocol includes support for using mirror sites, thus letting you locate and 
use a freedb server closer to your own location. By clicking on the [...] button to the right of the freedb 
server name CDGFix 3 Super will broadcast a query for currently available freedb mirror sites and 
present you with the result as a list. Note that currently there are no available freedb mirror sites, but 

this may change in the future. 

When using the HTTP protocol you may also have to tune the use of a HTTP proxy server. The default 
setting (Default) will use the proxy parameters set up by Windows. However, if you encounter problems 
you may try to turn HTTP proxy off (None) or select a specific proxy server (Specific) by entering proxy 
server name or address and the proxy port. 

Leaving the nifty gritty details on the freedb communication protocol we can concentrate on the options 
that control how CDGFix 3 Super will utilize the power of the freedb information: 

 Auto lookup in freedb when loading CD+G disc: With this option selected CDGFix 3 Super will 

automatically send freedb a request for information when a CDG disc is loaded into the Project 
window. If you turn off this option you can still request freedb information manually by selecting 
Load Title/Artist on the project Tools menu when the disc has been loaded. 

 Auto load tracks when only one match is found: It is possible that freedb returns more than one 

match for the loaded disc. In such cases you will be prompted with a dialog to browse and select 
the correct set of disc information. However, mostly only one hit is found, and CDGFix 3 Super 
can then automatically use this information without prompting you to confirm. 

 Format title/artist as selected for Disc Catalogs: When retrieving information from freedb you 

have no guarantee for how the information is formatted - that is entirely up to the person that 
registered the information originally. Selecting this option instructs CDGFix 3 Super to apply the 
formatting options set for Disc Catalogs to all information received from freedb. 
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 Log freedb communication: This option is for troubleshooting purposes only and will generate a 

log file for all freedb communication during the current CDGFix 3 Super session. 

 

 

 

Super CDG Libraries 

 

 

When a SuperCDG library is loaded into the Project window CDGFix 3 Super populates the various project 
columns with information about each track in the library. One of the columns contains information on the 
play length of the tracks, useful for various purposes. However there is a tradeoff for populating this 
column as CDGFix 3 Super will have to scan the entire SuperCDG library to get the length of each track. 

Depending on your needs you have three different options on determining the play length of each tracks: 

 Do not load the length of each track: This is the fastest method since it does not do anything to 

get the play length of the tracks, leaving the Length column empty. 

 Load the approximate track lengths: This method scans through the SuperCDG library and reads 

the length of the graphics for each track. This option gives best performance when you need to 
load the track lengths, but it is a bit inaccurate. Since the graphics often ends before the music 
you will get track lengths that are too short, ranging from a few seconds to maybe a minute or 
so. However you can get a reasonable idea of the length of the tracks. 

 Calculate the exact length of each track: This is both the most accurate and the most time 

consuming method - precision comes at a cost. Using this option CDGFix 3 Super will extract the 
MP3 file for each single track and calculate the accurate play length. 

Tip: You can abort the track length calculation during the load of a SuperCDG library by hitting the ESC 
key. 

The following option is available in CDGFix 3 Super version 3.6h and newer only 
 

 

Embed disc name and track number in library: CDGFix 3 Super has the ability to store the original disc 
name and track number from a CD+G disc in the SuperCDG library. When you build a new SuperCDG 
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library from a set of CD+G discs you will then have the information about original disc and track stored 

in the library. However, since this is a non-standard feature (not part of the SuperCDG standard by 
CAVS), the option can be disabled/enabled at your own choice. 

 

 

CAVS JB199 NCG Decryption 

 

 

CDGFix 3 Super has the capability of decrypting CAVS JB199 NCG files and convert them to another 
supported format (CDG+MP3, MCG+MP3, ZIP, BIN). In order to decrypt a NCG file CDGFix 3 Super 
needs to know the keyset originally used to encrypt the file. For many NCG files the keyset can be 
determined by simply scanning the NCG file, but depending on the original file source and format this is 
not always possible. 

To remedy this, CDGFix 3 Super utilizes the fact that all NCG files from the same JB199 unit are 
encrypted using the same keyset. This means that once you have successfully decrypted one NCG file 
you can save the keyset. CDGFix 3 Super will then use the saved keyset for subsequent NCG file from 
the same JB199 instead of attempting to detect it from scratch. 

Once you have successfully decrypted a NCG file from your JB199 you can open the Settings dialog and 
select this page. The current keyset ID will then be displayed at the top and the Register button will be 

enabled. Clicking on the Register button will register the keyset, making it appear in the bottom list. You 
can register as many JB199 keysets as you want - CDGFix 3 Super will always select the correct keyset 
for any given NCG file based on information in the file header. 

The bottom list shows all currently registered keysets. The Import button allows for import of keysets 
from a definition file. A keyset definition file is previously saved by selecting a registered keyset in the 
list and clicking on the Export button. Once you have a correct keyset we suggest that you make a 
backup of it using the Export function. 

The Unregister button is used if you want to remove a previously registered or imported keyset. This 
may be useful if the keyset turns out to be incorrect and you need CDGFix 3 Super to recalculate a new 
keyset using another NCG file. 

For more details on NCG files and keysets, and step by step instructions on how to use the NCG decoder, 
please refer to Convert encrypted NCG files. 
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Backup 

 

 

CDGFix 3 Super supports manual and automatic backup of tracks when they are loaded into the editor 
for modification. When doing large repair and/or modification jobs to a track a backup can be an easy 

way out if it turns out that the process went wrong. 

The settings on this page determines if and how CDGFix 3 Super will do automatic backup: 

 Do not make backup copies: No automatic backups are done. However, you can always make 

manual backups by selecting Backup Now on the File menu. 

 Make backup copies on demand: When a track is loaded into the editor it will be backed up 
automatically if a backup copy does not already exist. If a previous backup exists you will be 
prompted whether to replace the existing backup with a new one. 

 Always make backup copies: When a track is loaded into the editor it will be backed up 
automatically independently of whether an older backup exists or not, replacing any existing 
backup. 

 Make a backup copy once for each file: When a track is loaded into the editor it will be backed up 
automatically if a backup copy does not already exist. If a previous backup exists nothing will be 
done, i.e. only the first backup of the track is available for restore. 

The Empty Backup-folder button can be used to clean up the backup folder and remove all existing track 

backups. 

For more details on backup and recovery please refer to Backup and restore. 
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MRU File Lists 

 

 

Both the File menu and the Project menu contains a list of the most recently accessed tracks and 
projects, respectively. These lists are refereed to as Most Recently Used (MRU) lists, and are practical for 
fast access to recently used tracks and projects.. The maximum number of items displayed in the MRU 
lists are selected on this page, in the range from 0 to 9. Selecting 0 removes the MRU lists entirely. 

The two buttons can be used to remove the items on the File and Project MRU lists, respectively. 

 

 

 

Upgrading 
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CDGFix 3 Super has built-in support to check for new versions, and automatically download and install 

when available. The frequence of this check can be set on this page. 

The check for new versions are performed when CDGFix 3 Super is started, but limited by the selection 
in the above list as follows: 

 Check on every startup: The check for new versions are performed each time CDGFix 3 Super is 

started. 

 Only check once a day: The check is only performed the first time CDGFix 3 Super is started any 
given day. 

 Only check once a week: The check is only performed when it is minimum seven days since the 
last check. 

 Never check for new versions: CDGFix 3 Super will not do any automatic checks for new 

versions. 

Independently of the selected check interval you can always perform an ad-hoc check for new versions 
by selecting Check for new version now on the Options menu. 

 

CD/DVD-Drives 

 

 

CD/DVD-Drives 
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This page does not allow for changing any options, but is merely a source of information for the available 

CD and DVD drives. By selecting a drive in the drop down list at the top CDGFix 3 Super will display the 
capabilities for the drive. 

 CD-R: Indicates whether the selected drive can read CD-R media. 

 CD-RW: Indicates whether the selected drive can read CD-RW media. 

 Supports digital ripping: Indicates whether the selected drive supports ripping tracks on digital 

form. This is a requirement for CDGFix 3 Super to be able to load tracks from a CDG disc. 
SuperCDG DVDs however can be read independently of this capability. 

 Raw R-W sub-channel data: Indicates whether the selected drive can return sub-channel data 

during ripping. Sub-channel data is where the graphics are stored on CDG discs. If this option is 
not supported the drive only return the music without the graphics. Note that this option is 
sometimes reported incorrectly by the drive as not supported even if it is. In such cases CDGFix 
3 Super will issue a warning, but still let you try to rip the CDG disc. 

 De-interleaved and error corrected R-W data: Indicates whether the selected drive has built-in 

de-interleave and Error correction (Reed Solomon). Error correction is used to protect the 
graphics when the drive fails to read all data correctly due to scratches or other problems. If the 
drive does not support hardware error correction the returned data may be corrupted, resulting 
in bad spots and other garbage in the graphics. However, CDGFix 3 Super has built-in support 
for software de-interleave and Reed Solomon error correction that takes over if the drive can't 

do this.  As a result, and opposed to most other CDG ripping tools, CDGFix 3 Super is able to rip 
error free graphics from all drives that can return sub-channels, independently of the drive's own 
capabilities. 

 Maximum speed: Identifies the maximum reading speed of the selected drive. 

 Current speed: Identifies the currently set reading speed of the selected drive. The reading 
speed is set by the last program that accessed the drive. 

 

 

 

Reading 
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The options on this page control how CDGFix 3 Super responds to different CD/DVD drive events, and 

how CDG discs are ripped. 

 Load disc contents when a CD or DVD is inserted: Enabling this option makes CDGFix 3 Super 
monitor media load events for all available CD and DVD drives. When a disc is inserted CDGFix 3 
Super will attempt to detect the media type (CDG, SuperCDG, etc.) and respond accordingly. If 

a media type known to CDGFix 3 Super is detected the contents on the disc will be automatically 
loaded into the Project window. 

 Close project when the associated CD or DVD is ejected: Enabling this option makes CDGFix 3 

Super monitor media unload events for all available CD and DVD drives. When the disc that is 
currently loaded into the Project window - if any - is ejected the project will be automatically 
closed. 

 Eject associated CD or DVD when project is closed: Enabling this option makes CDGFix 3 Super 

eject the corresponding CD or DVD when the project is closed. A project can be closed by 
selecting Close on the Project menu, by opening a new project, or by closing CDGFix 3 Super. 

The value for Maximum number of accepted uncorrectable errors when reading track from CDG disc 
determines how many uncorrectable errors CDGFix 3 Super will silently accept when using the software 
Reed Solomon implementation. If this value is exceeded a warning will be issued to notify you of the 
problem. An excessive number of uncorrectable errors suggests that the disc is badly scratched or 
damaged. A new rip at a lower speed may give better results. Note that there will almost always be a 
few (typically 3 to 5) uncorrectable errors during ripping hence the default value of max 10 errors. 

The reading speed determines at which speed CDGFix 3 Super will read a CDG disc when ripping tracks. 
The list of available speeds are generic and may contain values that do not apply to the drive used. If an 
unsupported value is used the drive will silently fall back on it's default speed. If you experience 

problems during ripping of a CDG disc, for example due to scratches or other damage, you may try 
lowering the speed for better results. 

 

 
Submit CD+G Disc To freedb 
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Support: Make A Suggestion 

 

 

 
Support: Report A Problem/Bug 

 

 

 
Task Results Report 

 

 

 

 
Tile Block Normal and Tile Block XOR 

The Tile Block Normal/XOR dialog is one of the six CDG instruction editing dialogs. The other five dialogs 
are: 

Memory Preset 

Border Preset 

Scroll Copy and Scroll Preset 

Define Color Transparency 

Load Color Table 

 

The Tile Block dialog has the following basic layout: 
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By clicking the More button you will get an full view of the entire CDG canvas: 

 

A click on the Less button reverts to the basic layout. The full CDG canvas updates live to reflect any 
change done to the Tile Block instruction. 

The Plays On Channel block is used to select in which channel the instruction plays: 



CDGFix 3 Super help 

156 

 

The Tile Block Mode block toggles the instruction between Normal and XOR mode: 

 

The Position block is used to position the tile on the CDG canvas by selecting row and column: 

 

The position of the tile can also be changed by pointing at the tile in the extended view of the CDG 
canvas and dragging it to a new location while holding the left mouse button down. 

The Colors block defines the two colors - foreground and background - used to draw the tile: 

 

The main part of the dialog is the drawing and preview block: 

 

The leftmost rectangle is the drawing area. The 6 by 12 grid resembles the tile bitmap, where the dark 

cells are set and the white cells are cleared bits. The cleared bits are drawn with Color 1 and the set bits 
with Color 2. The rightmost rectangle is a 3 by 3 tiles preview with the current tile in the middle. The 
preview is updated live as the tile definition changes.  

The bits in the tile are by default toggled on and off by clicking them. Holding down the left mouse 
button and "dragging" across the drawing bitmap will toggle all bits that are touched. The top three 
buttons to the left of the drawing bitmap are used to select how bits are modified when clicked: 

The top button when selected makes all clicked bits set. 

Selecting the middle button makes all clicked bits cleared. 

Finally, the lower button, which is selected by default, makes all clicked bits toggle between set and 
cleared for each click. 
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The lower to buttons to the left of the drawing bitmap provides undo and redo functionality for 
operations in the drawing bitmap: 

 

The buttons to the right of the drawing bitmap are used for predefined tile patterns: 

The upper button is actually a drop-down list with predefined patterns. Selecting one of these 
patterns will set all the bits in the tile according to the selected pattern. 

The middle button will take the current tile definition and add to the list of predefined patterns. 

The bottom button removes the currently selected drop-down list pattern. 

 

Below the drawing area are three buttons to select how to display and preview the tile: 

Edit In Color changes the drawing bitmap from black and white to color, giving you a detailed view of the 
tile: 

 

For a Tile Block Normal instruction the color drawing bitmap will only show the two selected drawing 
colors. For a Tile Block XOR instruction on the other hand, the color view can be really useful because the 
resulting colors depend on the previous contents of the tile as much as the selected two drawing colors. 

The Color Indexes button is somewhat related to the Edit In Color function, but it shows the color 
indexes instead of the actual colors: 
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Also as for the Edit In Color function the usefulness primarily relates to the Tile Block XOR instruction. 

The Edit In Color and Color Indexes functions may of course be used together: 

 

Finally, the Include Packet button, that is used to select if the edited instruction is included in the 
preview or not. This can sometimes be of great help to determine how a Tile Block XOR instruction 

affects the existing tile bits: 

   

 

The Include Packet function also affects the colors and/or indexes in the drawing bitmap if selected: 
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The Restore button at the bottom left of the dialog is used if you want to restore the tile to the state it 
had when the dialog was opened, discarding any edits. It has the same effect as closing the dialog with 
the Cancel button and then reopening the same tile. 

For more information about this and other CDG instructions and their usage please refer to The CDG 
graphics format. 

 

 
Timeline 

 

 

 
Track Tile 
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View Current Colortable 

 

 

 

 
Hotkeys 

Hotkeys, also known as shortcut keys, are keyboard keys that when pressed together gives quick access 
to often-used menu items. The hotkeys supported by CDGFix 3 Super are as follows: 

 

Ctrl O File Open 

Ctrl S File Save 

Shift F4 File Close 

Ctrl P File Print 

Alt F4 File Exit 

  

Ctrl F1 View Size 100% 

Ctrl F2 View Size 200% 

Ctrl F3 View Size 300% 

Ctrl F4 View Size 400% 

Ctrl F5 View Size 500% 

Shift F1 View Size Fit 

Shift Ctrl 
F1 

View Size Full Screen 

Ctrl B View Border 

Ctrl D View Filter Packets Instructions Only 

Ctrl A View Filter Packets All Packets 

Shift Ctrl 
F9 

View Jump To 

F2 View Next Packet 

Shift F2 View HEX Editor 

  

F5 Play Start 

Shift F5 Play Restart 

F4 Play Pause 

F6 Play Stop 
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F8 Play Single Step 

Shift F8 Play Single Step Back 

Shift Ctrl 
F5 

Play Fast Forward 

Alt 
Backspace 

Play Rewind 

F9 Play Toggle Breakpoint 

Shift F9 Play Clear All Breakpoints 

Ctrl F9 Play Set Next Packet 

  

Ctrl Z Tools Undo 

Ctrl R Tools Recover Instruction 

Ctrl M Tools Remove Instruction 

Ctrl I Tools Change Instruction 

Ctrl C Tools Change Channel 

Ctrl T Tools Track Tile 

Ctrl L Tools Timeline 

Ctrl F Tools Search for Instruction 

Ctrl G Tools Search for Unknown Instruction 

Ctrl H Tools Search for Channel 

F3 Tools Selection Mark 

Shift F3 Tools Selection Clear 

  

Ctrl N Project New 

Ctrl Q Project Open 

Shift Ctrl 
F4 

Project Close 

Ctrl W Project Save 

Ctrl F7 Project Add File 

Ctrl F8 Project Add Folder 

Delete Project Remove Track 

  

Ctrl Insert Edit Copy Tracklist As CSV 

Shfit 
Delete 

Edit Clear 
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How to 

 

 
How to 

This chapter contains instructions on how to accomplish common tasks with CDGFix 3 Super. If you do 
not find what you are looking for we suggest you try the CDGFix forums, or contact our support 
department. You will find more information about doing so under  Technical support. 

 

 

 
Register your license key 

When you have purchased CDGFix 3 Super and received your license information you will need to enter 
your license key in order to start the full version of CDGFix 3 Super. When first started CDGFix 3 Super 
will display the License Key dialog to let you enter the registration information. Enter you information 

and click OK to confirm. 

If you at a later time need to change some of the information (for example your name or email address) 
you can select Product Key on the Help menu. This will bring up the same License Key dialog. 

For further details please refer to the description on this dialog for details. 

 

The following applies to CDGFix 3 Super version 3.5a and newer only 
 

 

Starting with version 3.5a of CDGFix 3 Super you are required to activate the software before it can be 
used. After entering registration information as described above you will next be prompted with the 
Product Activation dialog. Please refer to the documentation of this dialog, and the topic Activation of 

CDGFix for further details. 

 

 

 
Open a track for edit or play 

With CDGFix 3 Super there are basically two ways to open a track to play or edit it: 

 Select Open on the File menu. 

 Double-click the track in the Project window (or highlight the track in the Project window and 

select Load Track on the Project menu). 

 

File Open 

When you select Open on the File menu you will be presented with the Open File dialog. Depending on 
the type of track you want to open you as follows: 

 For CDG, MCG, MCG.MP3, NCG, BIN and ZIP tracks you simply navigate to and select the file. 

 For tracks in a SuperCDG library you first navigate to and select the CVMD0001.DAT file. This 

will bring up the Select SCDG Track dialog to let you select the track you want from the selected 
SuperCDG library. 

 For a track on a CDG disc you simply navigate to the drive containing the disc and the select the 

TRACKnn.CDA file for the track (nn is the track number, starting with 01 for the first track on the 
disc). 

If you open a track for edit please note that the track cannot be saved back to its original location if it is 
loaded from read-only storage, i.e. a SuperCDG or CDG disc. 

 

Project Window Load Track 
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When one or more tracks are loaded into the Project window you can load a track into the player/editor 

simply by double-clicking it. For information on how to load tracks into the Project window please refer to 
Working with projects. 

 

 
Repair with single steps and breakpoints 

 

 

 
Cut graphics and/or music 

 

 

 
Fix out-of-sync issues 

 

 

 
Change colors 

 

 

 

 
Working with projects 

The concept of a project is simply a collection of tracks that is stored as a single unit. Physically, the 
actual tracks may be stored in separate files and referenced by a tracks list stored in its own file, or all 
the tracks can be stored in one or more database files with a header listing the included tracks. CDGFix 3 
Super is capable of loading a project into the Project window, displaying the tracks in a uniform way 

independently of the physical storage format. The following project storage formats are supported: 

 Native CDGFix 3 Super projects - file type CFP 

 CAVS SuperCDG libraries - file type DAT 
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 RSQ NEO+G libraries - file type IFO 

 Cue sheet files - file type CUE 

 CAVS INX menu files - file type INX 

 CAVS Songlist and Juke files - file type TXT 

 CD+G discs 

For help on how to create a new project of one of the supported types please refer to Create a new 
project. This topic also includes guides on how to convert a project of one type to another. 

 

Native CDGFix 3 Super projects 

This is the most flexible project format: 

 Can store any number of tracks 

 Remembers the currently loaded track and play position, as well as any defined breakpoints 

(useful to save and restore a given work situation) 

 Remembers any highlighted tracks in the project window 

 Can mix different track formats in a single project 

 Can contain multiple CDG or SuperCDG discs in a single project, for example to build a single 

songbook for multiple discs 

 Can be used as a source for creating other project types for use by for example CAVS players 

Native projects are by default stored in the Projects folder created in the CDGFix 3 Super installation 
folder; by default this is C:\Program Files\CDGFix Crew\CDGFix 3.X Super\Projects. You may 
choose to save your projects in any location, however, using the default folder is recommended as all 
native project management functions (New, Open, Save As and Delete) starts in this folder. 

There are several ways of adding tracks to a native CDGFix 3 Super project: 

 Select Add File on the Project menu to add one or more tracks 

 Select Add Folder on the Project menu to recursively add all tracks in the selected folder and 

sub-folders 

 Drag and drop one or more files or folders on the Project window - a drop marker in the Project 

list will indicate where the dropped tracks will be inserted 

To remove one or more tracks from the project first highlight the track(s), and then select Remove Track 
on the Project menu - or simply press Delete. 

The track list can be rearranged simply by dragging single tracks to a new location in the list. 

 

CAVS SuperCDG libraries 

SuperCDG libraries are typically stored on dual-layer DVDs, but may also be stored on a HDD. A 
SuperCDG library consists of one or more DAT-files, named as CVMD0001.DAT, CVMD0002.DAT, and so 
on. When stored on a DVD the files should be located in a folder named CAVS_MCG to allow the various 
CAVS players to find them. 

On a dual-layer DVD a SuperCDG library normally consists of eight DAT-files, but any number of files 
that is a multiple of two can be used (limited to a maximum of 256). The addressing scheme of 
SuperCDG libraries limits the DAT-file size to 1 GB, imposing a limit of about 250 tracks per file (slightly 
depending on the track sizes). 

A new SuperCDG library can be created from the current project by selecting the Save As command on 

the Project menu. 

An existing SuperCDG library can be loaded into the Project window and then modified by adding or 
removing tracks, as well as changing titles and artist names, provided it is not stored on a read-only 
media (i.e. on a DVD). If stored on a read-only media the library must first be copied to the HDD and 
then modified there. When finished you can then burn a new DVD with the updated library. 

 

RSQ NEO+G libraries 
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NEO+G libraries are typically stored on dual-layer DVDs, but may also be stored on a HDD. A NEO+G 

library consists of one index file named NAVI.IFO and one or more DAT-files, named as NCDG_01.DAT, 
NCDG_02.DAT, and so on. When stored on a DVD the files should be located in the root of the disc to 
allow the various RSQ players to find them. 

On a dual-layer DVD a NEO+G library normally consists of eight DAT-files, but any number of files that is 
a multiple of two can be used (limited to a maximum of 64). The addressing scheme of NEO+G libraries 
limits the DAT-file size to 1 GB, imposing a limit of about 250 tracks per file (slightly depending on the 
track sizes). 

A new NEO+G library can be created from the current project by selecting the Save As command on the 
Project menu. 

An existing NEO+G library can be loaded into the Project window and then modified by adding or 
removing tracks, as well as changing titles and artist names, provided it is not stored on a read-only 
media (i.e. on a DVD). If stored on a read-only media the library must first be copied to the HDD and 

then modified there. When finished you can then burn a new DVD with the updated library. 

 

Cue sheets 

CUE sheets are text files that describe the tracks and their corresponding characteristics, and are used 
when burning audio (or CD+G) discs with some older burner softwares. CDGFix 3 Super can create CUE 
sheets when exporting tracks to the BIN format. 

When opening a CUE sheet in the Project window you can browse the various tracks, and load them into 

the player. However, a CUE sheet cannot be modified using CDGFix 3 Super. 

 

CAVS INX menus 

INX menus are database files that are used with some CAVS players - for instance the JB199 - and 
describe a set of tracks. The INX menu file contains titles and artist names, and references the tracks 
that are stored as separate files by index. The tracks are normally named 00001, 00002, and so on, and 
can be stored as one of the CAVS formats MCG+MP3, -MCG.MP3 or NCG+MP3. 

When opening an INX menu file in the Project window you can browse the various tracks, and load them 

into the player. However, an existing INX menu file cannot currently be modified using CDGFix 3 Super. 

CDGFix 3 Super can create a new INX menu file when exporting tracks to one of the supported INX menu 
track formats. 

 

CAVS Songlist and Juke files 

Songlist and Juke files are simple text files that are used with some CAVS players - for instance the JB99 
- and describe a set of tracks. The files contain titles and artist names, and references the tracks that are 

stored as separate files by index. The tracks are normally named 00001, 00002, and so on, and can be 
stored as one of the CAVS formats MCG+MP3, -MCG.MP3 or NCG+MP3. 

When opening a Songlist or Juke file in the Project window you can browse the various tracks, and load 
them into the player. However, an existing file cannot currently be modified using CDGFix 3 Super. 

CDGFix 3 Super can create a new Songlist or Juke file when exporting tracks to one of the supported 
track formats. 

 

CD+G discs 

This is the original CD+G Karaoke storage medium as defined by the Red Book. CDGFix 3 Super can load 
a CD+G disc into the Project window for direct playback, as well as for to export all or selected tracks to 
one of the supported track formats. 

When loading a CD+G disc CDGFix 3 Super by default tries to lookup the contents of the disc vie the 
Internet using the freedb disc catalog (this behaviour can be configured using the freedb Lookup page of 
the Settings dialog). You can also utilize various songbooks programs to load the disc information (please 
refer to Configure a disc lookup catalog for more information). 

 

 
Create a new project 
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- convert between project types 

 

 

 
Open an existing project 

 

 

 
A single project with multiple CDs and DVDs 

 

 

 

 
Configure a disc lookup catalog 

CDGFix 3 Super supports the concept of Disc Lookup Catalogs to help you load titles and artist names for 
tracks in the Project window. The main entrance to loading this information from a Disc Lookup Catalog 
is by selecting Load Title/Artist on the project Tools menu. This will bring up the Load Track Information 
dialog if your tracks are loaded from files on the HDD, or the Load Disc Tracks Info dialog if the tracks 

are loaded from a CD+G disc. 

However, before you can start using this feature in CDGFix 3 Super you must configure at least one disc 
lookup catalog. The catalogs - also known as songbook programs - supported by CDGFix 3 Super are: 

 Karaoke Song List Creator 

 KJ-Pro v1 and v2 

 Music Book Deluxe 

 FastTracks SongBook Creator 

In addition you can also use a CSV file as the source for disc lookup. This is useful if you do not own one 
of the above songbook programs but still have access to the information and can save it as a CSV file. 

To configure a disc lookup catalog in CDGFix 3 Super first select Settings on the Options menu. This will 
display the Settings dialog. Now select the Disc Catalogs page, and then open the page that corresponds 
to the songbook program you want to use. For details on how to set up each songbook program please 
refer to the corresponding help topics: 

 Karaoke Song List Creator 
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 KJ-Pro 

 Music Book Deluxe 

 FastTracks SongBook Creator 

 CSV File 

When the configuration is completed you are ready to use the disc lookup features of CDGFix 3 Super to 
ease you work for example when ripping CD+G discs. You can also browse the contents of a disc lookup 
catalog by selecting Browse Disc Catalogs on the main Tools menu. 

 

 
Load title, artist and other track information 

 

 

 

 
Using freedb 

freedb is a free CDDB compliant Internet based database for CDs. Although originally intended for 
standard audio CDs it will work just as good for Karaoke discs (CD+G). 

CDGFix 3 Super supports looking up CDs in freedb as well as submitting new entries. By default CDGFix 
3 Super consults freedb automatically when a Karaoke disc is loaded into the Project window. freedb 
bahaviour can be configured on the freedb Lookup page in the Settings dialog. 

When CDGFix 3 Super contacts freedb to lookup a CD and receives more than one match you will see the 
Select Disc dialog. This dialog presents the matches returned from freedb so you can browse them and 
select the one that is correct. Multiple matches can be returned from freedb because some CDs have tha 

same signature (same number of tracks with the same play length). Once you have selected the correct 
entry, or if only one entry was found, the Project list will be populated with titles and artist names for the 
tracks. If no match was found for your CD you will be notified about this by a message. 

 

Submitting new or updated entries to freedb 

Since freedb is a free service it depends on the user community to keep it up to date. CDGFix 3 Super 
supports submitting CD entries to freedb in a simple way. With the disc loaded into the Project window 

you start by filling in titles and artist names. This can be done either manually using the Edit Track 
dialog, or by loading the information from a disc lookup catalog. Once the information is correct you 
simply select Submit to freedb on the project Tools menu. Fill in the fields in this dialog and click Submit. 

By submitting new entries and/or correcting existing entries you participate in the process of helping 
others in having easy access to updated information for their Karaoke discs. 

 

 
ID3 tags - what, where and why 
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Convert multiple tracks between different formats 

 

 

 

 
Rip a CDG disc 

Ripping a CD+G disc to tracks on your HDD using CDGFix 3 Super basically consists of three simple 

steps. You can also rip a CD+G disc directly to either a SuperCDG or a NEO+G library. 

CDGFix 3 Super can use many types of both CD and DVD drives to rip CD+G discs. Even if your drive 
was not originally designed for it and thus is lacking built-in error correction you can get error free 
ripping. CDGFix 3 Super implements software Error detection and correction thus being able to correct 
errors that results from scratches and other problems with the disc and/or drive. However, if the errors 
are too massive the error correction can not correct all of them. 

 

Caution: We - the CDGFix Crew - encourage you to read and understand our Disclaimer before you 

optionally choose to rip a CD+G disc. 

 

1. Load the disc into the Project window 

To load a CD+G disc into the Project window you select Load Disc on the Project menu. 

By default CDGFix 3 Super detects when a disc is inserted into one of your computers removable drives 
and loads the disc automatically. This behaviour can be configured on the CD/DVD-Drives Reading page 
in the Settings dialog. 

 

Note: The Load Disc command requires that your computer has a working ASPI layer installed. For more 

information on ASPI and how to install it with CDGFix 3 Super please refer to ASPI.  

 

2. Load titles and artist names for the tracks 

When the disc is loaded into the Project window CDGFix 3 Super will by default consult the freedb 
Internet service to load titles and artist names for the tracks. More details on using freedb can be found 
at Using freedb. 

If freedb lookup is disabled, or if not entry is found for your disc, you have the option of using a disc 
lookup catalog instead. Select Load Title/Artist on the project Tools menu and enter the disc name. 
Please consult the information for the Load Disc Tracks Info dialog for more details. 

In order to use a disc lookup catalog you must first have one or more catalogs configured with CDGFix 3 
Super. You can find information on how to do this in Configure a disc lookup catalog. 

 

3. Export the CD+G tracks to the format you need 

When the disc is loaded and titles and artist names are in place you are ready to export the tracks to the 
format you want. Select Export Tracks on the Project menu to open the Export Tracks dialog. Make you 
choices for the export and simply click Run to save the tracks to your HDD. 

 

 
Create a CUE sheet for burning a CDG disc 
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Create a songbook 

 

 

 
Backup and restore 

 

 

 
Dual monitor system 

 

 

 
Cleanup ZIP-files 
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How to go CAVS 

 

 
How to go CAVS 

The purpose of this chapter is to describe typical tasks related to CAVS' hardware and software that 
CDGFix 3 Super can help you with. CDGFix 3 Super is not a tool dedicated to support CAVS' hardware 
and software, but some common tasks related to these topics can be simplified by CDGFix 3 Super. 

Please note that CAVS freely may choose to change their hardware and/or software specifications and 
capabilities. CDGFix Crew make no guaranties that the current release of CDGFix 3 Super will work with 
future releases of hardware and/or software from CAVS. However. when such changes are made by 
CAVS, CDGFix Crew will try to keep up with these changes in new releases of CDGFix. 

 

 

 
SuperCDG libraries 

The CAVS SuperCDG format is an ISAM like file structure used to organize hundreds or thousands of 
tracks in just a few data files instead of the CDG+MP3 file format. A SuperCDG library consists of at least 
one data file, but can contain up to 256 data files. The number of data files should be a power of two (1, 
2, 4, 8, etc.). For a SuperCDG library to be recognized by CAVS players and software the data files must 
be named CVMD0001.DAT, CVMD0002.DAT, CVMD0003.DAT and so on. CDGFix 3 Super on the other 
hand, recognizes SuperCDG libraries independently of the file names as long as the files have valid 
headers. The first data file (CVMD0001.DAT) also contains an index table of all the tracks in the library. 

A SuperCDG library comes in two formats; homemade and commercial. The homemade version is the 
one you can create with the software supplied by CAVS, while the commercial format is the one found on 
commercially distributed SuperCDG discs. The commercial format is also encrypted. CDGFix 3 Super can 
read and write both formats. 

The homemade SuperCDG format has an internal page size of 4096 bytes. Together with the addressing 
scheme of the SuperCDG library structure this limits the tracks that can be saved to a maximum of 1MB 
of graphics (MCG format) and 256MB of sound (MP3 format). Though the sound part is no real limitation 
the graphics may be. If you find that you have many tracks that do not fit into a homemade SuperCDG 
library you may want to switch to using the commercial format instead. This format has double the page 
size, i.e. 8192 bytes, and can thus hold twice as large tracks. The drawback of using the commercial 
format is that you will get more unused space in the data files, since each track must start on a page 
boundary, leaving unused space at the end of the previous track. The result is that each data file will 
hold slightly fewer tracks. 

The data files in a SuperCDG library are empty when created, and will grow as new tracks are added to 
the library. The tracks are evenly distributed across all the data files as they are added. The maximum 
size of each data file is limited to about 1 GB (see notes at the bottom for updated details). With an 

average track size of 4MB (MCG + MP3 files) this leaves room for about 250 tracks per data file. Creating 
a maximum size SuperCDG library with 256 data file thus enables you to organize as much as 64000 
tracks in one single unit. For SuperCDG libraries that you create and intend to burn onto a DVD there are 
obvious limitations of course. Refer to SuperCDG discs for more details on this topic. 

The index table in the SuperCDG library stores the titles and artist names for each tracks in the library. 
The length of this information is limited to 32 characters for the title and 16 characters for artist name. 
Though sufficient in some cases, this can lead to titles and artist names being truncated. As a remedy to 
this problem there is the list.txt file often seen along with a SuperCDG library. This is simply a text file 
with one indexed line for each track in the SuperCDG library, containing complete titles and artist names. 
If the file is not present the SuperCDG library will still work, but if the file is found it will supply any 
information that is truncated in the internal library index table. 

 

Creating a SuperCDG library 

Creating a new SuperCDG library using CDGFix 3 Super is quite easy, as is adding new tracks to an 
already existing library. 

Start by adding the tracks you want to the Project window. You are not required to add all tracks at the 
same time as it is easy to expand an existing SuperCDG library later, as described below. Then make 
sure that all tracks has the title and artist name in the appropriate columns in the project (you will get a 
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warning before building the SuperCDG library if some tracks are missing this information). For help on 

adding titles and artist names please refer to Load title, artist and other track information. 

When the tracks are in place in the project then select Save As on the Project menu. In the dialog that 
appears first select CAVS SuperCDG Libraries in the bottom drop-down list. Then enter the name of the 
new library and select where to save it. Note that if you intend to use the new SuperCDG library with 
CAVS players or software you must name it CVMD. When you click Save you will see a new dialog asking 
you whether to add all tracks or only the highlighted to the SuperCDG library. Confirm your choice and 
you will see the last dialog that allows you to select the number of data files and storage format for the 
new SuperCDG library. You should carefully consider the number of data files required based on how you 
intend to use the SuperCDG library and on how many tracks you intend to add to it. If the SuperCDG 
library eventually is going to be burned onto a DVD you can consult the topic SuperCDG discs for 
guidance. 

CDGFix 3 Super will now create the SuperCDG library as specified and start adding the selected tracks. 

You will see a progress dialog on the screen during the process. 

If you select an existing SuperCDG library in the Save As dialog you will be given the option of appending 
new tracks to this library, or overwriting it with a new one (this will of course delete all existing tracks in 
the library). If you choose to append tracks to the existing library you will not get the option of selecting 
the number of data files and library format. Instead CDGFix 3 Super will use the same parameters as 
were used when the library was created. 

The option of appending new tracks to an existing SuperCDG library is quite powerful since you do not 
have to have all tracks in place before starting on the library. It also allows you to rip tracks directly from 
multiple CD+G discs into a SuperCDG library without the need to store them temporarily on the HDD 
first. See the topic Rip a Karaoke disc directly to a SuperCDG library for more information on this. 

 

CDGFix 3 Super version 3.7 extends the maximum size of SuperCDG libraries 
 

 

Starting with version 3.7 it is possible to build SuperCDG libraries with data files up to 64GB in size each. 
Using the theoretical maximum of 256 data files in a single library, this allows you to build SuperCDG 
libraries as large as 16TB. However, for use with CAVS equipment the practical maximum number of 
data files is 16, leaving you with a library of 1TB. With an average song size of 4MB this will render a 
library containing more than 260000 songs. 

At the time of this writing large SuperCDG libraries with data file sizes up to 4GB have been tested 
successfully on CAVS 203G USB players. Using 16 data files this rendered a library of 64GB containing 
17000 songs. 

Despite the theoretical maximum data file size of 64GB there may possibly be a practical limit on 4GB as 

far as CAVS equipment is concerned. However, if you intend to use a SuperCDG library solely as a song 
archive for use with CDGFix 3 Super you can utilize the maximum size of 16TB - assuming you have the 
disk it takes. 

 

 

 
SuperCDG discs 

A CAVS SuperCDG disc is simply a DVD (or CD, though less common due to the limited size) that 
contains a single SuperCDG library. Since SuperCDG library data files are not of a fixed size (they grow 
as you add new tracks to the library) you should be careful when building the library to keep the total 
size of the data files within the space limits of the media you intend to burn onto. It is good practice to 
hold the data file sizes slightly below 1GB (more precisely, at a maximum of 1018MB each) to allow for 

four data files on a single-layer DVD and eight data files on a dual-layer DVD. If you need to fill the DVD 
to its maximum capacity you can start by adding about 200 tracks per data file (i.e. 800 tracks for a 
single-layer DVD and 1600 tracks for a dual-layer DVD) and then add more tracks in smaller chunks 
while monitoring the total size of the SuperCDG library during the process. 

See the topic SuperCDG libraries for details on how to create a SuperCDG library and for more 
information regarding number of data files and tracks. 

When you create a SuperCDG library for use with SuperCDG players or software you must make sure 
you name the library CVMD. When the library is finished simply use a burning software of your choice 
and burn the data files (CVMD0001.DAT, CVMD0002.DAT, etc.) onto the DVD in a folder named 
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CAVS_MCG. When finished the SuperCDG disc should contain one  folder, CAVS_MCG, that contains the 

library data files. 

It is possible to create self-loading SuperCDG discs that auto-runs an embedded player when inserted 
into a computer. Read more on this topic at Create a self-loading SuperCDG DVD. 

 

 

 
Rip a SuperCDG disc 

CDGFix 3 Super can read both commercial and homemade SuperCDG discs. Your computer must be 
equipped with a DVD drive capable of reading the disc - note that most commercial SuperCDG DVDs are 
dual-layer. 

 

Caution: We - the CDGFix Crew - encourage you to read and understand our Disclaimer before you 

optionally choose to rip a SuperCDG disc. 

 

 

Rip your SuperCDG disc 

To rip the tracks from your SuperCDG disc to one of the supported formats you basically need to perform 
two steps: 

1. Load the SuperCDG disc into the CDGFix 3 Super Project window 

2. Run the Export Tracks function to perform the actual ripping 

 

1. Loading a SuperCDG disc into the Project 

Loading the SuperCDG disc into the Project window is as simple as selecting Load Disc on the Project 
menu or the Project toolbar. In the dialog that is displayed select the drive containing your SuperCDG 
disc. 

 

Note: The Load Disc command requires that your computer has a working ASPI layer installed. If you 
don't have ASPI installed you can instead select Open on the Project menu and browse to the drive 
where the SuperCDG disc is loaded, open the CAVS_MCG folder and select the CVMD0001.DAT file.  

 

CDGFix 3 Super will now read the index table on the SuperCDG disc and populate the Project window 
with track titles and artist names. You are now ready to export tracks to the format you want. 

 

Tip: You can change the formatting of titles and/or artist names before the export by selecting Format 

Title/Artist on the project Tools menu. 

 

2. Exporting the tracks to a selected format 

The export process is quite simple. Select Export Tracks on the Project menu to bring up the Export 
Tracks dialog. Using this dialog select your options for the ripping and click Run. Please refer to the 
description of this dialog for more details on this process. 

 

 

 
Create a self-loading SuperCDG DVD 

When you insert a commercially made SuperCDG disc into your computers DVD drive you will normally 
experience that the disc auto loads and starts an embedded SuperCDG player. Using this player you can 
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instantly play the contents on the SuperCDG disc without having any pre-installed software for the 

purpose on the computer. 

If you have a commercial SuperCDG disc you can use the contents on this disc to create your own self-
loading SuperCDG discs with your favorite songs. Here are the simple steps to follow. 

1. Create an empty folder on your HDD to hold the required files for your new self-loading 
SuperCDG disc. 

2. Insert the commercial SuperCDG disc into your computers DVD drive and open it up in Windows 
Explorer. 

3. Copy all contents on the SuperCDG disc - except from the CAVS_MCG folder - into the empty 
folder you created in step 1. 

4. Create an empty folder named CAVS_MCG in the folder your created in step 1. 

5. Use CDGFix 3 Super to create a SuperCDG library as explained in SuperCDG libraries. Make sure 
the new SuperCDG library is named CVMD and save it in the CAVS_MCG folder you created in 

step 4. IMPORTANT: The new SuperCDG library must be created as Commercial, 
encrypted". 

6. Open the CAVS_MCG folder created above and copy the file List.txt over to the DiskCdg folder 
copied from the commercial SuperCDG disc - replace the existing List.txt file. 

7. Burn all files and folder now present in the folder you created in step 1 to a blank DVD. When 
finished the root of the new DVD should contain the folders CAVS_MCG and DiscCdg along with 
about five files (the number of files may vary slightly). 

When you insert the newly created DVD into a computers DVD drive you should now experience the 
same as with a commercially created SuperCDG disc, an auto-load of a player to let you access the songs 
on the disc. 

 

 

 
Rip a Karaoke  disc directly to a SuperCDG library 

Using CDGFix 3 Super it is possible to rip CD+G discs directly to a SuperCDG library without having to 
first store the tracks temporarily on the HDD. When you have many CD+G discs that you want to convert 
to a SuperCDG library this  feature can save you both work and storage space. 

To rip a CD+G disc directly to a SuperCDG library start by following steps 1 and 2 as described in the 
topic Rip a CDG disc. Then, instead of using the Export Tracks function as described in step 3 you will 
instead select Save As on the Project menu to create, or append to, a SuperCDG library. More details on 
creating and appending to SuperCDG libraries can be found in the topic SuperCDG libraries. 

By using this procedure for each CD+G disc you can easily create a new SuperCDG library from multiple 
CD+G discs. 

 

 

 
INX menu 

The file ENGLISH.INX is used by some CAVS players, for instance the JB199, to facilitate faster access to 
the tracks available to the player. The INX menu file is basically a simple ISAM database with tables of all 
titles and artist names sorted alphabetically, with pointers to each track on disc. The file is a binary data 
file and cannot be edited manually. 

CDGFix 3 Super can build an INX menu file while exporting tracks using the Export Tracks command on 
the Project menu. Building an index file is only available when exporting tracks using the sequential 
numbering option for file naming. Please refer to the topic on Export Tracks for more details. 

It is also possible to build an INX menu file without having to export a set of tracks. Using the Create 
Indexfile command on the project Tools menu you can build an INX menu file from either the collection 
of tracks currently loaded into the Project window or from another index file (for example Juke.txt or 

Songlist.txt). Please refer to the topic on Create Indexfile for more details. 
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Songlist.txt 

The file SONGLIST.TXT is used by some CAVS players to organize access to the tracks available on the 

player. The SONGLIST file is simply a text file with one line for each available track. Each line is divided 
into three fields by vertical bars (|). The first field is the number of the track, which also denotes the 
track file name, followed by title and last artist name. 

CDGFix 3 Super can build a SONGLIST file while exporting tracks using the Export Tracks command on 
the Project menu. Building an index file is only available when exporting tracks using the sequential 
numbering option for file naming. Please refer to the topic on Export Tracks for more details. 

It is also possible to build a SONGLIST file without having to export a set of tracks. Using the Create 
Indexfile command on the project Tools menu you can build a SONGLIST file from either the collection of 
tracks currently loaded into the Project window or from another index file (for example INX menu or 
Juke.txt). Please refer to the topic on Create Indexfile for more details. 

 

 

 
Convert encrypted NCG files 

The CAVS player JB199 has a way of registering karaoke files by converting them to NCG format. This 
format is encrypted using a key based on the specific JB199 to which the files are registered. If you loose 
the original files you are pretty much stuck to the JB199 for playing them unless you use CDFix 3 Super 
to decrypt the NCG files back to an open format, for example CDG+MP3. 

 

Caution: If your JB199 player came with pre-loaded songs we - the CDGFix Crew - encourage you to 

read and understand our Disclaimer before you optionally choose to decrypt these songs off of the JB199 
player.  

 

CDGFix 3 Super has a NCG decrypter that, based on the known structure of the CAVS MCG and CAVS 
CDG proprietary formats, is able to reverse the encryption process. This is done by examining the NCG 
file and by iteration create the required keyset to decrypt the file. A brute force attempt of this kind could 
be very time consuming, but since CDGFix 3 Super makes use of intelligent guesses based on the known 
format structure the keyset is derived in seconds. Hence loading a NCG file into CDGFix is just as fast as 
loading any other format karaoke file. 

 

Convert your NCG files 

To convert your NCG files to one of the supported formats you basically need to perform two steps: 

1. Load the NCG files into the CDGFix 3 Super Project window 

2. Run the Export Tracks function to perform the actual conversion 

 

1. Loading NCG files into the Project 

Your NCG files can be loaded into the Project window in various ways. The simplest is dragging them 
from Windows Explorer and dropping onto the Project window. Another option is to select Add File or Add 
Folder on the Project menu or the Project toolbar. 

As the NCG files are added to the Project CDGFix 3 Super will search the corresponding MP3 file for each 
track looking for ID3 tags. If tags are found then title, artist name, etc. will be loaded from the tags and 
placed in the corresponding columns in the Project. If all your tracks are properly tagged as they should 
be you are now ready for step two, exporting the tracks to your selected format. 

If however for some reason some or all of the tracks are missing ID3 tags you may want to remedy this 
before the export. You can still export the tracks to another format, but you will not be able to name the 
exported files using titles and artist names. 

Normally NCG files from a JB199 are simply named 00001, 00002 and so on, containing no useful 
information for identifying the track. Should your files have meaningful names you can use the Load 

Track Information function to extract this information prior to the export. 
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A last resort before starting to type in the titles and artist names by hand is to use one of the index files 

normally present together with the NCG files on the JB199. The index files can have names like 
English.inx, Songlist.txt, List.txt and Juke.txt. CDGFix 3 Super is able to read all these files and utilize 
the information found. To use one the index files you will, instead of dragging the NCG files directly into 
the Project window, select Open on the Project menu and navigate to and select the index file. It is 
important that the NCG files are located in the same folder as the index file, or in a sub-folder of the 
index file folder. CDGFix 3 Super will now read the selected index file and load each referenced NCG file 
along with title and artist name into the Project window. 

 

Tip: You can change the formatting of titles and/or artist names before the export by selecting Format 

Title/Artist on the project Tools menu. 

 

2. Exporting the tracks to a selected format 

The export process is quite simple. Select Export Tracks on the Project menu to bring up the Export 
Tracks dialog. Using this dialog select your options for the conversion and click Run. Please refer to the 
description of this dialog for more details on this process. 
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Glossary 

A 
ASPI: ASPI stands for Advanced SCSI Programming Interface, and is shortly described a 

programmingand communications layer between software products (like CDGFix 3 Super) and 
SCSI (and ATAPI) storage devices (like CD and DVD drives). ASPI provides a standardized way 
for transferringcommands and data between the software and the storage devices. ASPI was 
originallydeveloped by Adaptec. 

C 
CDG: Compact Disc Graphics (also known as CD+G) is the physical storage format defined by Philips and 

Sony used to add graphics to a audio disc (compact disc or CD). The CDG format definition is 
part of the "Red Book". 

H 
HDD: A hard disk drive (HDD), commonly referred to as a hard drive, hard disk, or fixed disk drive, is an 

internal or external disk that stores your data permanently. 

I 
ISAM: ISAM stands for Indexed Sequential Access Method, a method for indexing data for fast retrieval. 

In short an ISAM database consists of one or more data files with data organized into records, 
and one or more index files with pointers to each record for fast access. 

V 
VBR: Variable Bit Rate (VBR) is a method of MP3 encoding that utilizes the fact that different parts of a 

song requires different bitrates to achieve the same quality. Quiet parts of a song requires less 
information, while more complex or dynamic sequences needs more data to deliver tha same 
quality. 
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